
آموزش مقدماتی 
QGIS 3.10

نجمه مظفری پور
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QGIS 3.10
آماده سازی محیط نقشه1.
(Attributes)کار با ویژگی ها2.
CSVوارد کردن صفحات گسترده یا پرونده های 3.

(QGIS3)اصول استایل بندی لایه وکتوری 4.

(QGIS3)محاسبات آماری طول خط 5.

شبکه ای: اصول اولیه تحلیل و استایل بندی داده های رستری6.

(Clipping)رستری و برش دادن( Mosaicing)موزاییک7.

(Terrain Data)زمینی/کار با داده های رقومی8.

WMS( Web Map Service)کار با داده های 9.

(Projections)زمین مرجع کردن10.

(QGIS3)زمین مرجع کردن نقشه ها در فایل های رستری11.

( (QGIS3زمین مرجع کردن تصاویر هوایی12.

نقشه( Digitizing)رقومی سازی 13.

OpenStreetMapجستجو و بارگیری داده های 14.
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QGIS 3.10
آزادویکی پدیا، دانشنامهٔ از 

 کیوجی آی اس(انگلیسی :QGIS ) با نام پیشین کوانتوم جی آی اس(Quantum GIS) متن بازو چندسکویینرم افزار آزاد
.  استداده های مکانیاست که قادر به تولید، نمایش، ویرایش و تحلیل (GIS)سامانه اطلاعات جغرافیایی

ترسیم نقشهون کیوجی آی اس مانند دیگر نرم افزارهای جی آی اس به کاربران اجازه می دهد تا با استفاده از تکنیک های گوناگ ،
گرافیک و  ک برداریگرافیدر این نرم افزار نقشه ها در قالب های مختلف از جمله  . لایه های مختلف نقشه را تولید و ترسیم کنند

. و برای کاربردهای گوناگون به کار گرفته می شوندشطرنجی

QGIS با سایر بسته هایGIS  منبع باز ، از جملهPostGIS ،GRASS GIS وMapServer قابلیت
.داردادغام

 نوشته شده به زبان های هایافزونهPython یاC ++این امکان را بهQGIS  را گسترش ش یهامی دهد که قابلیت
 Googleافزونه ها می توانند با بسیاری از ابزار ها و بستر های موجود ارائه سرویس نقشه در تعامل باشند مانند. دهد

Geocoding API  مشابه ابزارهای استاندارد موجود در عملکردهای ژئوپروسس، انجامArcGIS و رابط با ،
PostgreSQLپایگاههای / PostGIS ،SpatiaLite وMySQLو.... 
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https://fa.wikipedia.org/wiki/%D8%B2%D8%A8%D8%A7%D9%86_%D8%A7%D9%86%DA%AF%D9%84%DB%8C%D8%B3%DB%8C
https://fa.wikipedia.org/wiki/%D9%86%D8%B1%D9%85%E2%80%8C%D8%A7%D9%81%D8%B2%D8%A7%D8%B1_%D8%A2%D8%B2%D8%A7%D8%AF
https://fa.wikipedia.org/wiki/%D8%B3%DA%A9%D9%88%DB%8C_%D8%B1%D8%A7%DB%8C%D8%A7%D9%86%D8%B4
https://fa.wikipedia.org/wiki/%D9%85%D8%AA%D9%86%E2%80%8C%D8%A8%D8%A7%D8%B2
https://fa.wikipedia.org/wiki/%D8%B3%D8%A7%D9%85%D8%A7%D9%86%D9%87_%D8%A7%D8%B7%D9%84%D8%A7%D8%B9%D8%A7%D8%AA_%D8%AC%D8%BA%D8%B1%D8%A7%D9%81%DB%8C%D8%A7%DB%8C%DB%8C
https://fa.wikipedia.org/wiki/%D8%AF%D8%A7%D8%AF%D9%87%E2%80%8C%D9%87%D8%A7%DB%8C_%D9%85%DA%A9%D8%A7%D9%86%DB%8C
https://fa.wikipedia.org/wiki/%D8%AA%D8%B1%D8%B3%DB%8C%D9%85_%D9%86%D9%82%D8%B4%D9%87
https://fa.wikipedia.org/wiki/%DA%AF%D8%B1%D8%A7%D9%81%DB%8C%DA%A9_%D8%A8%D8%B1%D8%AF%D8%A7%D8%B1%DB%8C
https://fa.wikipedia.org/wiki/%DA%AF%D8%B1%D8%A7%D9%81%DB%8C%DA%A9_%D8%B4%D8%B7%D8%B1%D9%86%D8%AC%DB%8C
https://fa.wikipedia.org/w/index.php?title=PostGIS&action=edit&redlink=1
https://fa.wikipedia.org/w/index.php?title=GIS_GASS&action=edit&redlink=1
https://fa.wikipedia.org/w/index.php?title=MapServer&action=edit&redlink=1
https://fa.wikipedia.org/wiki/%D8%A7%D9%81%D8%B2%D8%A7%DB%8C%D9%87
https://fa.wikipedia.org/wiki/%D9%BE%D8%A7%DB%8C%D8%AA%D9%88%D9%86_(%D8%B2%D8%A8%D8%A7%D9%86_%D8%A8%D8%B1%D9%86%D8%A7%D9%85%D9%87%E2%80%8C%D9%86%D9%88%DB%8C%D8%B3%DB%8C)
https://fa.wikipedia.org/wiki/%D8%B3%DB%8C_%D9%BE%D9%84%D8%A7%D8%B3%E2%80%8C%D9%BE%D9%84%D8%A7%D8%B3
https://fa.wikipedia.org/w/index.php?title=SpatiaLite&action=edit&redlink=1
https://fa.wikipedia.org/wiki/%D8%A2%D8%B1%DA%A9_%D8%AC%DB%8C%E2%80%8C%D8%A2%DB%8C%E2%80%8C%D8%A7%D8%B3
https://fa.wikipedia.org/w/index.php?title=PostGIS&action=edit&redlink=1
https://fa.wikipedia.org/wiki/%D9%BE%D8%B3%D8%AA%DA%AF%D8%B1%D8%B3%E2%80%8C%DA%A9%DB%8C%D9%88%D8%A7%D9%84
https://fa.wikipedia.org/w/index.php?title=PostGIS&action=edit&redlink=1
https://fa.wikipedia.org/w/index.php?title=SpatiaLite&action=edit&redlink=1
https://fa.wikipedia.org/wiki/%D9%85%D8%A7%DB%8C%E2%80%8C%D8%A7%D8%B3%E2%80%8C%DA%A9%DB%8C%D9%88%D8%A7%D9%84
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کاربر گرامی
ویری و گویا این آموزش به همراه فایلهای آموزشی برای هر بخش به صورت کاملا تص•

. طراحی شده است
یاز هر پس از نصب نرم افزار می توانید برای آموزش تمرینی خود، داده های مورد ن•

جستجو و استفاده را بخش کتاب را در فولدر مخصوص بارگزاری کنید تا براحتی قابلیت
.داشته باشد

•

نحوه استفاده از این آموزش

mailto:mozaffaree_1987@yahoo.com


آماده سازی محیط نقشه. 1
• Unzip Natural Earth Quickstart Kit.

. را باز کنیدQGISنرم افزار •
کلیک کرده و فولدر را باز کنید و پروژه ی Natural Earth quick startبر روی فولدر •

Natural_Earth_quick_start_for_QGIS_v3را با دبل کلیک باز کنید.
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http://naciscdn.org/naturalearth/packages/Natural_Earth_quick_start.zip
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هایی برای تنظیم زبان در این پروژه از متغی . ممکن است متوجه شوید که این نقشه دارای برچسب هایی به زبان یونانی است
ما می توانیم متغیها را با رفتن به . استفاده می شود

Project ‣Properties

.تغیی دهیم

m
o

z
a

ff
a
re

e
_

1
9

8
7
@

y
a
h

o
o

.c
o

m
ور

ی پ
فر

مظ
ه 

جم
ن

mailto:mozaffaree_1987@yahoo.com


را پیدا کنید و بر روی project_languageمتغی . برویدProject Propertiesدر پنجره ی Variablesبه تب 
.کلیک کنیدOKتغیی دهید و بر روی name_enزبان را در . کلیک کنید تا ویرایش شودValueستون 
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اکنون نقشه ارائه شده با. کلیک کنیدMap Navigationدر نوار ابزار Refresh، بر روی دکمه QGISدر پنجره اصلی 
.برچسب های انگلیسی مشاهده خواهید کرد
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.استفاده کنید و ژاپن را بزرگنمایی کنید Map Navigationدر نوار ابزار  zoomو  panاز 
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می توانید برخی از لایه های نقشه را برای داده هایی که برای این نقشه به آنها نیازی ندارید خاموش کنید.

 پوشهz5 - 1:18m را گسترش دهید و تیک کنار لایهne_10m_geography_marine_polys و
ne_10m_admin_0_disputed_areasرا بردارید  .
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ن  قبل از تهیه نقشه مناسب برای چاپ ، باید پروجکشن(موقعیت زمین مرجع :CRS )مناسبی را انتخاب کنیم.

CRS پیش فرض برای این پروژه رویEPSG:3857 Pseudo-Mercator تنظیم شده است.
 اینCRSناسبی است ، ای است که به طور گسترده برای نقشه برداری تحت وب استفاده می شود و برای اهداف ما انتخاب م

.بنابراین می توانیم آن را به صورت پیش فرض قبول کنیم
 بهProject ‣ New Print Layout بروید.

mailto:mozaffaree_1987@yahoo.com


.کلیک کنیدOkمی توانید آن را خالی بگذارید و روی . از شما خواسته می شود عنوانی را برای طرح وارد کنید
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.به آن اختصاص می یابد Layout 1با گذاشتن نام لی اوت خالی، یک نام پیش فرض مانند 

.کلیک کنید تا میزان کامل چیدمان نمایش داده شودZoom full، روی دکمه Print Layoutدر پنجره 

mailto:mozaffaree_1987@yahoo.com


.می بینیم به لی اوت بیاوریمQGISرا که در بوم ( map view)حال باید نمای نقشه
‣ Add Itemبه   Add Mapبروید
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ن وارد کنید پس از فعال شدن حالت افزودن نقشه ، دکمه سمت چپ ماوس را نگه دارید و مستطیلی را که می خواهید نقشه را در آ
.بکشید
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ا نقشه ارائه شده ممکن است کل منطقه مورد علاقه ما ر . رندر خواهد شدQGISخواهید دید که پنجره مستطیل با نقشه از بوم اصلی 
‣ Editبرای ویرایش نقشه از. پوشش ندهد Select/Move وEdit ‣ Move

.استفاده کنید تا نقشه در مرکز صفحه جانمایی شود
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را به عنوان 10000000کلیک کرده و Propertiesبرای این کارروی گزینه ی . کیزان بزرگنمایی را نیز برای نقشه تنظیم کنید
.مقیاس وارد کنید
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اکنون یک ستون نقشه اضافه می کنیم که نمای بزرگنمایی را برای منطقه توکیو نشان می دهد.
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 قبل از ایجاد تغیی در لایه ها در پنجره اصلیQGIS ها ، در جعبه  لایهlayers وstylesاین کار . را تیک بزنید
.نخواهد کردتغیی viewدهیم، این می کند که اگر برخی از لایه ها را خاموش کنیم یا سبک های آنها را تغیی تضمین 

mailto:mozaffaree_1987@yahoo.com


 به پنجره اصلیQGISگروه لایه ای . برویدz5 - 1:18m  را خاموش کنید و گروهz7 - 1: 4mاین گروه . را فعال کنید
در نوار ابزار zoomو  panاز کنترلهای . لایه ای دارای یک ظاهر طراحی شده است که برای بزرگنمایی مناسب تر است

Map Navigationاستفاده کرده وتوکیو را بزرگنمایی کنید.
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اکنون ما آماده اضافه کردن برگه نقشه هستیم.
.  را تغیی دهید Print Layoutپنجره 

‣ Add Itemبه   Add Mapبروید.
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اکنون متوجه خواهید شد که ما در. یک مستطیل را در محلی که می خواهید ستون نقشه اضافه شود بکشیدPrint Layout2
. نقشه داریم

.بنابراین هنگام ایجاد تغییات ، اطمینان حاصل کنید که نقشه صحیح انتخاب شده است
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ن .  را که اخیاً از پانل آیتم ها اضافه کرده ایم ، انتخاب کنیدMap 2نقشه 

.  را انتخاب کنیدItem propertiesبرگه 
.رفته و کادر کنار آن را علامت بزنیدFrameبه سمت قاب 

ی تغییات را تشخیص می توانید رنگ و ضخامت حاشیه قاب را تغیی دهید ،به صورتی که می توان در پس زمینه نقشه به راحت
.داد

mailto:mozaffaree_1987@yahoo.com


ر نشان این است که می تواند به طور خودکار منطقه را از نقشه اصلی که در قسمت زیPrint Layoutیکی از ویژگی های منظم 
.داده شده است ، برجسته کند

Map 1در تب . را از پانل آیتم ها انتخاب کنیدItem properties به بخش ،Overviews(پایین )روی دکمه . بروید
.افزودن یک نمای کلی جدید کلیک کنید
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نشان داده Map 2فعلی در موقعیت 1Mapمی گوید تا Print Layoutاین به . را به عنوان قاب نقشه انتخاب کنید2نقشه 
.شود
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.اکنون که چیدمان نقشه آماده است ، به نقشه اصلی شبکه بندی را اضافه می کنیم
Map 1در تب . را از پانل آیتم ها انتخاب کنیدItem properties، یعنی (پایین)به قسمتGrids بروید  .

...Modify gridبر روی دکمه افزودن یک شبکه جدید کلیک کنید و در ادامه 
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ه صورت با این حال ، نمایش خطوط شبکه ب. نقشه فعلی استفاده می کنندCRSبطور پیش فرض ، خطوط شبکه از همان واحد ها و 
.  معمول و مفیدتر است( degrees)درجه 

.کلیک کنیدCRSکنار ... Changeبر روی دکمه . متفاوتی را برای شبکه انتخاب کنیمCRSما می توانیم 
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از نتایج ، . وارد کنیدFilterرا در کادر Coordinate Reference System Selector  ،4326در منوی
WGS84 EPSG:4326 را به عنوانCRS انتخاب کنید وOKرا کلیک کنید.
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ی را تنظیم کنید تا جایی که خطوط شبکه ظاهر مOffsetمی توانید . انتخاب کنیدYو Xدرجه برای 5مقادیر فاصله را به ترتیب 
.شود تغیی کند
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قالب پیش فرض درجه است اما به صورت. را تیک بزنیدDraw Coordinatesبروید و کادر Grid frameبه قسمت 
در کنار آن کلیک Expressionرا انتخاب کنید و روی دکمه Custom. را اضافه کنیم° ما می توانیم نماد. عدد ظاهر می شود

.کنید
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.را بر روی آن ضمیمه کند° ایجاد کنید که عدد شبکه را بگید و نماد ( string)عبارت زیر را وارد کنید تا یک رشته 
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دلخواه ، چپ ، راست ، تنظیمات موقعیت را بصورت. توجه کنید که شبکه ها اکنون دارای یک برچسب سفارشی از عبارت ما هستند
.بالا و پایین تنظیم کنید
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.دحالا یک قاب مستطیل اضافه خواهیم کرد تا عناصر دیگر نقشه مانند جهت شمال ، مقیاس و برچسب را نشان ده
‣ Add Itemبه  Add Shape ‣ Add Rectangleبروید.
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.برای مطابقت با پس زمینه ی نقشه می توانید رنگ مستطیل را تغیی دهید
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از جمله انواع-با مجموعه ای زیبا از تصاویر مربوط به نقشه QGIS. اکنون یک علامت جهت شمال به نقشه اضافه خواهیم کرد
.  همراه است-مختلف جهت های شمالی 

‣ Add Itemروی  Add Picture کلیک کنید.
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.  با نگه داشتن دکمه سمت چپ ماوس ، یک مستطیل بکشید
کلیک کرده و بخش جستجوی فهرست ها را گسترش داده وItem Propertiesدر سمت راست صفحه  ، بر روی تب 

.تصویر دلخواه خود را انتخاب کنید
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.  اکنون نوار مقیاس را اضافه می کنیم
‣ Add Itemروی  Add Scalebarکلیک کنید.
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.روی لی آوتی که در آن می خواهید نوار مقیاس ظاهر شود کلیک کنید
.  را برای نمایش نوار مقیاس انتخاب کرده ایدMap 1، مطمئن شوید که نقشه صحیح  Item Propertiesدر برگه 

.سبکی را انتخاب کنید که متناسب با نیاز شما باشد
.واحد تغیی دهید و بخش ها را به دلخواه خود تنظیم کنید200، عرض ثابت را به  Segmentsدر پنل 
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.وقت آن است که نقشه را برچسب گذاری کنیم
‣ Add Itemبر روی  Add Labelکلیک کنید.
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. بر روی نقشه کلیک کنید و جعبه ای را که در آن برچسب قرار دارد بکشید
.  را گسترش داده و یک برچسب برای نقشه وارد کنیدLabel، بخش Item Propertiesدر برگه 

.به همین ترتیب برچسبهای دیگری برای اعتبار داده و نرم افزار اضافه کنید
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برای این .  صادر کنیدSVGیا PDFهنگامی که از نقشه نهایی رضایت کافی حاصل شد، می توانید آن را به صورت تصویر ، 
بر روی. آموزش ، اجازه دهید آن را به عنوان تصویر صادر کنیم

Layout ‣ Export as Imageکلیک کنید.
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.خروجی گرفتیمPNGما از تصویر به صورت . تصویر را در قالب دلخواه خود ذخیه کنید
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 (Attributes)کار با ویژگی ها. 2
 attributesو   features: استدارای دو بخش  GISداده های •
و انجام پرسشهای  GISبرداری در لایه های یک در این آموزش نحوه مشاهده ویژگی . هستند featureداده های ساختاری در مورد هر ( attributes)هاویژگی   •

 .نشان داده شده است QGISاصلی در مورد آنها در 
•Earth Natural  یک مجموعه داده ازPopulated Places  دهدارائه می. 
 _m_populated_places_simple.zip10neدانلود داده های •
 .قرار دهید و آنرا گسترش دهید QGISدر مرورگر را  ne_10m_populated_places_simple.zip فایل•
 .انتخاب کرده و آن را به بوم بکشیدرا   ne_10m_populated_places_simple.shpشیپ فایل •
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http://www.naturalearthdata.com/downloads/10m-cultural-vectors/10m-populated-places/
http://www.qgistutorials.com/downloads/ne_10m_populated_places_simple.zip
http://www.qgistutorials.com/downloads/ne_10m_populated_places_simple.zip
http://www.qgistutorials.com/downloads/ne_10m_populated_places_simple.zip
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بارگیری می شود و نقاط بسیاری را نشان می دهد که  QGISدر  ne_10m_populated_places_simpleاکنون یک لایه جدید 
 .  مکان های پر جمعیت جهان را نشان می دهد

 نوار ابزار. استمرتبط   attributesدارایهر نقطه همچنین . را نشان می دهد GISژئومتری لایه  QGISپیش فرض در بوم نمای 

Attributes  این نوار ابزار شامل ابزارهای مفیدی برای بازرسی ، مشاهده ، انتخاب و اصلاح ویژگی های یک لایه است. پیدا کنیدرا. 
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View ‣ Toolbars ‣ Attributes Toolbar 
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ویژگی . پس از انتخاب ابزار ، روی هر نقطه روی بوم کلیک کنید. کلیک کنید  Attributesبر روی دکمه شناسایی در نوار ابزار 
پس از انجام کاوش در خصوص ویژگی های نقاط . های مرتبط با آن نقطه در یک پانل شناسایی جدید نتایج نمایش داده می شوند

 .کلیک کنید  Closeمختلف ، می توانید روی دکمه 
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 .ببینیمکنیم ، می توانیم همه آنها را به صورت جدول مشاهده  ویژگی را هر باریک جای اینکه به 
همچنین می توانید روی لایه . کلیک کنید  Attributesدر نوار ابزار  Open Attribute Tableروی دکمه بر 

ne_10m_populated_places_simple    راست کرده و کلیکOpen Attribute Table را انتخاب کنید. 

m
o

z
a

ff
a

re
e

_
1

9
8

7
@

y
a

h
o

o
.c

o
m

ر 
و
پ
 
ی
ر
ف
ظ
م
 
ه
م
ج
ن

  
  
  

 

mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com


برای مرتب . این قسمت شامل جمعیت محل مرتبط است. را پیدا کنید pop_maxمی توانید به صورت افقی حرکت کرده و ستون 
 .قسمت کلیک کنیدهر سازی ستون به ترتیب نزولی ، می توانید دو بار روی 
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مانند برای انجام سؤالات  -SQLاز عبارات  QGIS. اکنون ما آماده هستیم تا درخواست خود را در مورد این ویژگی ها انجام دهیم
 .را انتخاب کنید Select features using an expression. استفاده می کند
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دو بار کلیک   pop_maxرا گسترش داده و بر روی برچسب  Fields and Valuesبخش  Select By Expressionدر پنجره 
 .  قسمت عبارت اضافه شده استبه متوجه خواهید شد که . کنید
برای . کلیک کنید تا ببینید که مقادیر ویژگی در مجموعه داده چیست  All Uniqueدر مورد مقادیر فیلد مطمئن نیستید ، می توانید بر روی دکمه اگر 

 Selectبنابراین عبارت زیر را کامل کنید و بر روی . میلیون نفر باشد 1این تمرین به دنبال پیدا کردن تمام ویژگی هایی هستیم که جمعیت آنها بیش از 

Properties و سپس بستن کلیک کنید. 

m
o

z
a

ff
a

re
e

_
1

9
8

7
@

y
a

h
o

o
.c

o
m

ر 
و
پ
 
ی
ر
ف
ظ
م
 
ه
م
ج
ن

  
  
  

 

"pop_max" > 1000000  
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پنجره لیبل نیز تغییر می کند و تعداد ویژگی های . متوجه خواهید شد که اکنون چند ردیف در جدول ویژگی ها انتخاب شده اند
 .انتخاب شده را نشان می دهد
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 .بازگردید QGISپنجره جدول ویژگی را ببندید و به پنجره اصلی 
 .شوددیده می رنگ زرد نقاط به متوجه خواهید شد که اکنون زیر مجموعه ای از   
 .هستند 1000000بیشتر از  pop_maxویژگی است و نقاط انتخاب شده مواردی هستند که دارای پرسش ما این نتیجه   
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 .روزرسانی کنیمبه حال بیایید پرسش را 
 . شرط پایتخت بودن را نیز اضافه کنیممیلیون ،  1بر داشتن جمعیتی بزرگتر از علاوه 

 Attributesدر نوار ابزار  Select features by Expressionمی توانید از دکمه برای دستیابی سریعتر به ویرایشگر، 
 .استفاده کنید
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 .است adm0capپایتخت ها حاوی داده های مربوط به این فیلد 
 .  استنشان می دهد که مکان یک پایتخت  1مقدار  

 .  معیار را به عبارت قبلی خود اضافه کنیماین   andعملگر می توانیم با استفاده از ما 
 کلیک کنید( Close)سپس بستن و  Selectزیر را وارد کنید و روی گزینه های عبارت 
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"pop_max" > 1000000 and "adm0cap" = 1  
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 .  برگردید QGISبه پنجره اصلی 
 .از نقاط انتخاب شده را مشاهده خواهید کردکوچکتری زیر مجموعه  اکنون 

نشان می دارند را میلیون  1و همچنین جمعیتی بیش از هم پایتخت کشورهستند دوم است و همه مکانها را از مجموعه داده هایی که ی سؤال این نتیجه  
 .دهد
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 .خروجی بگیریمعنوان یک لایه جدید به های انتخاب شده میخواهیم از ویژگی اکنون 
 .بروید ...Export ‣ Save Selected Features Asبه کلیک راست کرده و  ne_10m_populated_places_simpleروی لایه 
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 .کنیدانتخاب  را به دلخواه خود فرمتی شما ممکن است هر 
 .  را انتخاب خواهیم کرد GeoJSONاین تمرین ، برای 

GeoJSON  وب استفاده می شودهای تحت یک فرمت مبتنی بر متن است که به طور گسترده در نقشه  . 
 .وارد کنیدفایل خروجی را به عنوان  populated_capital.geojsonکنید و فایل کلیک  نام کنار ... روی بر 
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 .  انتخاب کنیدبه عنوان خروجی شما می توانید فقط زیرمجموعه ای از ستون های اصلی را . داده های ورودی ستون های زیادی دارند
کلیک کنید و   Deselect Allروی گزینه . دهیدرا گسترش   Select fields to export and their export optionsقسمت 

 را کلیک کنید OK. تایید کنیدرا  pop_maxستون و   nameفقط ستون 
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لایه تازه صادر شده ، می توانید در برای مخفی کردن آن و مشاهده نقاط . بارگیری می شود QGISدر  populated_capitalیک لایه جدید 
 .را علامت بزنید ne_10m_populated_places_simpleلایه 

m
o

z
a

ff
a

re
e

_
1

9
8

7
@

y
a

h
o

o
.c

o
m

ر 
و
پ
 
ی
ر
ف
ظ
م
 
ه
م
ج
ن

  
  
  

 

mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com


 CSVوارد کردن صفحات گسترده یا پرونده های . 3

 .  در یک جدول یا صفحه گسترده اکسل است GISبسیاری از اوقات داده های •
 .خود وارد کنید GISهمچنین ، اگر لیستی از مختصات طولانی دارید ، می توانید به راحتی این داده ها را در پروژه •
قبل از میلاد ، مجموعه ای بزرگ از همه زمین لرزه های مهم را تولید می   2150از سال  NOAAمرکز داده های ژئوفیزیکی ملی : داده ها•

 .کند
text file. Significant Earthquake DatabaseDownload  

signif.txt 
منبع داده جدولی خود را بررسی کنید. 
  برای وارد کردن این داده ها بهQGIS  ستون که حاوی مختصات  2، شما باید آن را به عنوان یک فایل متنی ذخیره کنید و حداقل بهX 

 .است نیاز دارید Yو 
  اگر صفحه گسترده ای دارید ، از برنامهSave As  در برنامه خود استفاده کنید تا آن را به عنوان فایلTab Delimited File  

 .ذخیره کنیدComma Separated Values (CSV )یا یک فایل مقادیر
  پس از صادر کردن داده ها به این روش ، می توانید آن را در یک ویرایشگر متن مانندNotepad   باز کنید تا محتویات را مشاهده

در مورد بانک اطلاعات زلزله های قابل توجه ، داده ها از قبل به عنوان یک فایل متنی تهیه شده است که شامل عرض و طول . کنید
 .  جغرافیایی مراکز زلزله به همراه سایر ویژگی های مرتبط است
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http://www.ngdc.noaa.gov/nndc/struts/results?type_0=Exact&query_0=$ID&t=101650&s=13&d=189&dfn=signif.txt
http://www.qgistutorials.com/downloads/signif.txt
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 .جدا شده است TABمشاهده می کنید که هر قسمت توسط یک 
m

o
z
a

ff
a

re
e

_
1

9
8

7
@

y
a

h
o

o
.c

o
m

ر 
و
پ
 
ی
ر
ف
ظ
م
 
ه
م
ج
ن

  
  
  

 

QGIS3  دارای یککککککککککک مککککککککککدیریت داده یک ار ککککککککککه
اسککت کککه بککه شمککا امکککان مککی دهککد  ککا  فرمککت هککای 

 .مختلف داده پشتیبانی شده را بارگیری کنید
 بکر روی دکمککهOpen Data Source 

Manager  در نکوار ابکزارData Source  
همچنکککین مکککی توانیکککد از میکککان  صکککفحه  . کلیکککک کنیکککد

 .استفاده کنید Ctrl + Lکلید 

Latitude  موقعیت شمال و جنوب یک نقطه را مشخص می کند و از
 .است Yاین رو یک مختصات 

Longitude   غربی یک نقطه را مشخص می کند و  -موقعیت شرقی
 .است Xیک مختصات 
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 .بروید Delimited Textبه برگه •
 .کلیک کنید و مسیر فایل متنی را که بارگیری کرده اید مشخص کنید  Fileکنار نا  ... روی دکمه •
 .را علامت بزنید Tabرا انتخاب کرده و  File format  ،Custom delimitersدر بخش  •
بکه صکورت خودککار تن کیم مکی  Geometry definitionتعریکف  secctionمناسب ،  Yو  Xدر صورت پیدا کردن زمینه های مختصات •

 . شود
 .هستند LATITUDEو  LONGITUDEدر اینجا برای ما، آنها •
 .بگذارید EPSG:4326 WGS84را به صورت پیش فرض  Geometry CRSمی توانید  •
 .  مناسب را در اینجا انتخاب کنید CRSمتفاوت است ، می توانید  CRSاگر فایل شما دارای مختصات  •
 .تأیید را بزنید•
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 .وارد و نمایش داده می شوند signifبه عنوان یک لایه جدید به نا   QGISاکنون خواهید دید که داده ها در بو  
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 (QGIS3)اصول استایل بندی لایه وکتوری . 4
 .کرده و آن را به شکلی ارائه دهد که از لحاظ بصری آموزنده باشد(استایل بندی )  styleبرای ایجاد نقشه ، باید داده های مربوط به اطلاعات جغرافیایی را •
 .وجود دارد(  symbology)برای استفاده از انواع مختلف نمادشناسی  QGISتعداد زیادی گزینه در •
 spatial)برای برجسته کردن الگوهای مکانی(  visualization)در این آموزش ، ما از یک فایل متنی استفاده خواهیم کرد و از تکنیک های مختلف تجسم داده•

patterns )در داده ها استفاده خواهیم کرد. 
 :  داده ها•

• globalpowerplantdatabasev120.zip 

• ne_10m_land.zip 

 .، مسیری را که داده ها در آن قرار دارند را پیدا کنید QGISدر صفحه مرورگر . کنید   Unzipهر دو مجموعه داده را در پوشه خود •
 .لایه را به بوم بکشید. را انتخاب کنیدne_10m_land.shpرا گسترش داده و لایه  ne_10m_landپوشه  •
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http://www.qgistutorials.com/downloads/globalpowerplantdatabasev120.zip
http://www.qgistutorials.com/downloads/globalpowerplantdatabasev120.zip
http://www.qgistutorials.com/downloads/globalpowerplantdatabasev120.zip
http://www.qgistutorials.com/downloads/ne_10m_land.zip
http://www.qgistutorials.com/downloads/ne_10m_land.zip
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 .اضافه می شود Layersبه پنل  ne_10m_landیک لایه جدید
 .است که ما نیاز به وارد کردن آن داریم CSVبانک اطلاعات جهانی نیروگاه ها به عنوان یک پرونده 

همچنین می توانید از میانبر صفحه کلید . کلیک کنید  Data Sourceدر نوار ابزار  Open Data Source Managerبر روی دکمه 
Ctrl + L استفاده کنید. 
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 .بروید Delimited Text، روی برگه  Data Source Managerدر پنجره 
 .در آن قرار دارد بروید globalpowerplantdatabasev120.zipدکمه کنار نام پرونده کلیک کنید و به فهرست راهنمایی که فایل ... بر روی 

global_power_plant_database.csv را انتخاب کنید. 
 QGIS بطور خودکار زمینه های محدود کننده(delimiter  )و ژئومتری را تشخیص می دهد. 
 Geometry CRS  را به مقدار پیش فرضEPSG:4326 - WGS84 بگذارید. 
 .روی افزودن کلیک کنید و سپس آن را ببندید 
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به پنل لایه ها اضافه می شود و نقاطی را نشان می دهد که نیروگاه  global_power_plant_databaseیک لایه جدید 
 Open theروی دکمه پنل . اکنون ما آماده هستیم تا هر دو لایه را استایل بندی کنیم. های موجود در بوم را نشان می دهد

Layer Styling  در بالای پانلLayers  کلیک کنید. 
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 .در سمت راست باز خواهد شد Layer Stylingپنل 
 .را انتخاب کنید ne_10m_landابتدا لایه  

 .این لایه ی مبنای ما خواهد بود بنابراین می توانیم یک ظاهر استایل بندی شده ی حداقلی برای آن داشته باشیم
 .  کنید   Fill colorمطابق میل خود . کلیک کنید و به پایین بروید   Simple fillروی 

 .را انتخاب کنید Transparent Strokeکلیک کرده و    Stroke colorروی کشوی کنار 
 .  این باعث می شود که طرح های چندضلعی زمین شفاف بنظر برسند 

 .نتیجه انتخاب شما بلافاصله روی لایه اعمال می شود
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 .  را انتخاب کنید global_power_plant_databaseسپس لایه 
 .یک نشانگر مثلثی را انتخاب کنید. کلیک کنید و به پایین بروید Simple markerروی 
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 .  پر کنید  Fill colorبه بالا بروید و رنگ دلخواه خود را در 
 .  است Stroke color یک روش مفید کارتوگرافی؛ انتخاب کمی تیره تر

 .قابلیتی برای کنترل دقیق تر این مسئله ارائه می دهدQGISبه جای انتخاب دستی ، 
 .را انتخاب کنید( Edit)کلیک کنید و ویرایش    Data defined overrideبر روی دکمه 
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 .را بزنید OKشود و   fill color٪ تیره تر از 30عبارت زیر را وارد کنید تا رنگ سایه آن 
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darker(@symbol_color, 130)  
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این نشان می دهد که این ویژگی توسط یک  -به رنگ زرد در آمده است   Stroke colorدر کنار   Data defined overrideمتوجه خواهید شد که دکمه 
 .کنترل می شود( override)رأی

 .  این اطلاعات به جز محل نیروگاه ها اطلاعات زیادی منتقل نمی کند. برای نیروگاه جالب نیست single symbolنمایش  
 .را انتخاب کنید Categorizedکلیک کرده و گزینه ی   Symbologyروی نماد کشویی . بیایید از یک رندر متفاوت برای مفیدتر کردن آن استفاده کنیم

m
o

z
a

ff
a

re
e

_
1

9
8

7
@

y
a

h
o

o
.c

o
m

ر 
و
پ
 
ی
ر
ف
ظ
م
 
ه
م
ج
ن

  
  
  

 

mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com


 .شامل یک ویژگی است که سوخت اصلی مورد استفاده در هر نیروگاه را نشان می دهد global_power_plant_databaseلایه 
 .ما می توانیم استایلی را ایجاد کنیم که در آن هر نوع سوخت با رنگی متفاوت نشان داده شود 
  primary_fuel  را به عنوان ستون انتخاب کنید. 
 .کلیک کنید Classifyروی  

 .برای شما چند دسته نمایش داده می شود که می توانید رندر نقشه متناسب با آن را تغییر دهید
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 .داری تفسیر کندعنادر حالی که یک نمایش طبقه بندی شده مفید است ، این لایه حاوی دسته بندی های زیادی است که هر یک از آنها می تواند نقشه را به طور م
 .یک روش بهتر این است که گروه خاصی از دسته بندی های سوخت را طبقه بندی و تعداد کلاس ها را کاهش دهیم 
 (.Other)و سایر(  Non-renewable fuel)، سوخت غیر قابل تجدید( Renewable fuel)سوخت قابل تجدید -دسته ایجاد کنیم  3بیایید سعی کنیم  
پس از انتخاب ، بر . و کلیک بر روی هر سطر ، همه جز یک قاعده را انتخاب کنید Ctrlبا نگه داشتن کلید . را انتخاب کنید( Rule-based)رندر مبتنی بر قاعده 

 .روی دکمه حذف قواعد انتخاب شده کلیک کنید تا آنها حذف شوند

m
o

z
a

ff
a

re
e

_
1

9
8

7
@

y
a

h
o

o
.c

o
m

ر 
و
پ
 
ی
ر
ف
ظ
م
 
ه
م
ج
ن

  
  
  

 

mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com


 .قواعد باقیمانده را انتخاب کنید و روی ویرایش قاعده فعلی کلیک کنید
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کلیک    Filterکنار   Expressionبر روی دکمه . را به عنوان برچسب وارد کنید( Renewable fuel)سوخت تجدید پذیر
 .کنید
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 .را بزنید OKعبارت زیر را وارد کنید و  Expression String Builderدر پنل 
 .در اینجا ما چندین گروه انرژی تجدیدپذیر را در یک گروه واحد دسته بندی می کنیم 
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"primary_fuel" IN ('Biomass', 'Geothermal', 'Hydro', 'Solar', 'Wind', 'Storage', 'Wave and Tidal')  

mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com


 .پس از اتمام ، بر روی دکمه بازگشت کلیک کنید. رنگ مناسب را انتخاب کنید. کلیک کنید   Simple markerروی 
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 .  شما یک قاعده واحد را مشاهده خواهید کرد که برروی لایه طبقه سوخت تجدید پذیر اعمال می شود
 .را انتخاب کنید Pasteدوباره کلیک راست کرده و . را انتخاب کنید Copyروی ردیف، راست کلیک کنید و 
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 .سطر تازه اضافه شده را انتخاب کنید و روی ویرایش قانون فعلی کلیک کنید. نسخه ای از قاعده ی موجود اضافه می شود
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 .کلیک کنید  Filterکنار   Expressionبر روی دکمه . سوخت غیر قابل تجدید را به عنوان برچسب وارد کنید
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 .را کلیک کنید OKعبارت زیر را وارد کنید و  Expression String Builderدر گفتگوی 
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"primary_fuel" IN ('Coal', 'Gas', 'Nuclear', 'Oil', 'Petcoke')  
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 .پس از اتمام ، بر روی دکمه بازگشت کلیک کنید. رنگ مناسب را انتخاب کنید. کلیک کنید   Simple markerروی 
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 .آن را انتخاب کرده و روی ویرایش قانون فعلی کلیک کنید. را تکرار کنید تا یک قاعده ی سوم اضافه شود Copy / Pasteفرایند 
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 .را به عنوان برچسب وارد کنید( Other)سایر
 .قرار دهید( Catch all for other features)بجای یک فیلتر ، همه موارد دیگر را -را انتخاب کنید  Elseگزینه   
 .قاعده قبلی جای نگرفته، دراین قاعده  قرار می گیرد 2این تضمین می کند که هر دسته بندی که در  
 .  کلیک کنید  Simple markerبه پایین حرکت کرده و روی  

 .پس از اتمام ، بر روی دکمه بازگشت کلیک کنید. رنگ مناسب را انتخاب کنید
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 .  طبقه بندی مجدد اکنون کامل شده است
ا و توزیع آنها در سراسر کشور را ه هشما نمای بسیار تمیز تری مشاهده خواهید کرد که توزیع منابع تجدیدپذیر در مقابل منابع سوخت غیر قابل تجدید استفاده شده توسط نیروگا

 .  نشان می دهد
 .می توانیم متغیر دیگری را به استایل بندی اضافه کنیم. با این حال تصویر کاملی ارائه نمی دهد

 .  به جای نمایش همه نشانگرها با اندازه یکنواخت ، می توانیم اندازه متناسب با ظرفیت تولید نیروگاه هر نیرو را نشان دهیم 
 .را انتخاب کنید Change Sizeروی قانون سوخت تجدید پذیر کلیک راست کرده و . به این تکنیک نقشه برداری ، نقشه برداری چند متغیره گفته می شود
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 .ویرایش را انتخاب کنید. کلیک کنید  Sizeدر کنار  Data defined overrideبر روی دکمه 
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 ه ،از آنجا که ظرفیت تولید برق در میان مجموعه داده های ما بسیار متفاوت است ، یک روش مؤثر برای بدست آوردن دامنه ای کوچک برای انداز 
 .است  log10استفاده از عملکرد 

 .شما می توانید با عبارات مختلفی آزمایش کنید تا به آنچه مد نظر دارید، برسید 
 .را کلیک کنید OKعبارت زیر را وارد کنید و  
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log10("capacity_mw") + 1  
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 .همین روند را برای قوانین دیگر تکرار کنید
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 .را ببندید Layer Stylingپس از رضایت از استایل ، می توانید پنل 
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 .  با نگاهی به پردازش نهایی، می توانید بلافاصله الگوهای موجود در مجموعه داده را مشاهده کنید
تری نسبت به کم  به عنوان مثال ، در اروپا نیروگاه های بیشتری وجود دارند که از منبع انرژی تجدید پذیر استفاده می کنند ، اما از ظرفیت نیروگاه های

 .نیروگاه هایی که از منبع انرژی تجدید پذیر استفاده نمی کنند ، استفاده می کنند
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 (QGIS3)محاسبات آماری طول خط . 5
•QGIS  غیره استطول ، مساحت ، محیط و محاسبات هندسی دارد که شامل محاسبات توابع داخلی و الگوریتم هایی برای. 
داده نشان (  feature)برای هرعارضه ویژگی برای اضافه کردن ستونی با مقدار نمایانگر طول هندسی این آموزش نحوه استفاده از ابزار افزودن در •

 .در آمریکای شمالی ، طول کل راه آهن در ایالات متحده را تعیین خواهیم کردلایه ی خطوط ریلی توجه به در این تمرین با . شدخواهد 
 :  داده ها•

• ne_10m_railroads_north_america..zip 
شیپ فایل . در صفحه مرورگر پیدا کرده و آنرا گسترش دهیدرا  ne_10m_railroads_north_america.zipپرونده بارگیری شده •

ne_10m_railroads_north_america.shp را روی بوم بکشید. 
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که در پنل لایه ها بارگذاری شده است مشاهده خواهید  را   ne_10m_railroads_north_americaیک لایه جدید 
عارضه حال ، بگذارید طول هر . شمالی استدرآمریکای آهن خطوط راه خواهید دید که این لایه دارای خطوطی است که نماینده . کرد

 .به جعبه ابزار پردازش بروید. را محاسبه کنیمی خطی 
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Processing ‣ Toolbox 
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برای راه اندازی . را جستجو کنید و آن را پیدا کنید Vector geometry ‣ Add geometry attributesالگوریتم 
 .آن دوبار کلیک کنید
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 .  به عنوان لایه ورودی انتخاب کنیدرا  ne_10m_railroads_north_america، لایه Add Geometry Attributesپنل در 
 .  است EPSG:4326 WGS84لایه ورودی سیستم مرجع 

به   degreesو زمین مرجع بیضوی عنوان به   WGS84با طول و عرض جغرافیایی به عنوان مختصات ،  Geographic CRSیک این 
 .  عنوان واحد است

 .  مسطح با دقت اندازه گیری کنیدهندسی آنجا که طول و عرض جغرافیایی طول استاندارد ندارند ، نمی توانید مسافت ها یا مناطق را با استفاده از توابع از 
روشی بهتری برای محاسبه مسافت ها با استفاده از هندسه بیضوی ارائه می دهد ، که دقیق ترین روش برای لایه هایی است که در  QGIS، خوشبختانه 

 . مناطق بزرگی مانند این وجود دارد
 .  پنجره را ببندیدکنید پس از اتمام مراحل ، کلیک  ( Run)اجرا روی . انتخاب کنید Calculate usingرا به عنوان گزینه  Ellipsoidalگزینه 
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این یک کپی از لایه ورودی است با یک ستون . را مشاهده می کنید Layersدر پنل  Added geom infoجدید لایه 
 Open Attributeکلیک راست کرده و   geomروی لایه اضافه شده اطلاعات . جدید که برای فاصله اضافه شده است

Table را انتخاب کنید. 

m
o

z
a

ff
a

re
e

_
1

9
8

7
@

y
a

h
o

o
.c

o
m

ر 
و
پ
 
ی
ر
ف
ظ
م
 
ه
م
ج
ن

  
  
  

 

mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com


همچنین توجه . استعارضه خطی بر حسب متر طول هر ستون شامل این . در جدول ویژگی ها ، یک ستون جدید با نام فاصله را مشاهده خواهید کرد
 .را ببندید Attribute Tableپنجره . است نیز ایجاد شده استکه شامل کد رمزگذاری برای هر ویژگی  sov_a3عارضه داشته باشید که 
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 .را پیدا کنیمخطوط راه آهن تا طول کل با هم جمع کنیم ، می توانیم آنها را را به صورت جداگانه داریم راه آهن هر قطعه خط اکنون که طول 
 .باید فقط از بخش های موجود در ایالات متحده استفاده کنیمداریم ، به طول کل راه آهن در ایالات متحده ما نیاز اما از آنجا که  

راست کرده و کلیک   Added geom infoروی لایه . کنیم تا لایه فیلتر شوداستفاده   sov_a3ستون  توانیم از مقدار کد کشور در می 
Filter را انتخاب کنید. 
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 .کلیک کنیدرا   OKعبارت زیر را وارد کنید و  Query Builderپنل در 
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"sov_a3" = 'USA'  
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فیلتر روی لایه اعمال شده دهد قرار دارد که نشان می  Layersپانل در  Added geom infoدر کنار لایه  Filterخواهید دید که یک نماد 
 .  است

مسافت اکنون ما آماده محاسبه . ایالات متحده استخطوط ریلی بصری تأیید کنید که این لایه اکنون فقط دارای بخش های توانید به صورت می همچنین 
 .کلیک کنید  Attributesدر نوار ابزار ( Show statistical summary)آماریبر روی دکمه نمایش خلاصه . هستیم
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 .انتخاب کنیدرا   lengthو ستون  Added geom infoلایه . باز خواهد شد( Statistics) آماریک پانل جدید 
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برحسب  بیایید محاسبه را . متر استیعنی (  length)واحد ستون طولهمان آماری واحد . داده شده اندپنل نمایش در آمارهای مختلفی 
 .کلیک کنید  Statisticsکنار منوی کشویی قسمتها در پانل در    Expressionروی نماد بر . کیلومترتغییردهیم
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 .کنیدکند، وارد  که طول را به کیلومتر تبدیل    Expression Dialogعبارت زیر را در 
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length / 1000  
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 .راه آهن در ایالات متحده استکل خطوط طول  شده، نمایش داده  Sumمقدار 
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 شبکه ای: اصول اولیه تحلیل و استایل بندی داده های رستری.6
 .شودرستری می مشاهدات و تحقیقات علمی زیادی باعث ایجاد مجموعه داده های •
•  Raster ها شبکه پیکسل هایی هستند که مقدار خاصی به آنها اختصاص داده شده است. 
 .انجام دادهای جالبی با انجام عملیات ریاضی بر روی این مقادیر می توان تجزیه و تحلیل   •
•  QGIS  دارد که از طریق تحلیلی را برخی از قابلیت هایRaster Calculator صورت می گیرد. 
 .بررسی خواهیم کردرا  Raster Calculatorقابلیت های ارائه شده توسط استایل بندی رستری و در این آموزش گزینه های موجود برای   •
 .استفاده خواهیم کرد 2010تا  2000جهانی جمعیت بین سالهای در خصوص تغییر برای ایجاد نقشه موضوعی رستری جمعیت ما از داده های •
 :  داده ها•

• gpw-v4-population-count-rev11_2000_2pt5_min_tif.zip 

• gpw-v4-population-count-rev11_2010_2pt5_min_tif.zip 
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Gridded Population of the World (GPW) v4  

dataset from Columbia University 
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QGIS را باز کرده و فایلهای بارگیری شده را در پانل مرورگر پیدا کنید. 
 .کنیدرا باز   gpw-v4-population-count-rev11_2000_2pt5_min_tif.zipفایل  

 .به بوم بکشیدرا   gpw-v4-population-count-rev11_2000_2pt5_min.tifسپس فایل عکس 
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 .پانل لایه ها اضافه می شودبه   gpw-v4-population-count-rev11_2000_2pt5_minیک لایه جدید 
 پیدا کرده را  gpw-v4-population-count-rev11_2010_2pt5_min_tif.zipفایل به همین ترتیب   

 .بر روی بوم بکشیدرا   gpw-v4-population-count-rev11_2010_2pt5_min.tifو فایل عکس 
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 .بیایید این لایه ها را بررسی کنیم
پس از انتخاب ابزار ، روی هر نقطه روی بوم کلیک  . کلیک کنید  Attributesدر نوار ابزار (  Identify)شناساییروی دکمه بر 

 .کنید
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 .  داده می شودنمایش  Identify Resultsجدید مقدار مرتبط با آن پیکسل در یک پانل 
 .  دهیدتغییر   Top downپنل شناسایی نتایج ، حالت را به در 
 .بالاترین لایه نمایش داده می شودرسترها جایگزین فقط این کار مقادیر پیکسلی همه با 
 .مقادیر هر دو لایه را با هم مقایسه کنید  

است که توسط پیکسل نشان داده شده ( کیلومتر مربع  25)کیلومتر است ، مقادیر پیکسل نشان دهنده کل جمعیت منطقه   5کیلومتر در   5آنجا که وضوح تصویری تقریباً از 
 .است
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 . پانل شناسایی نتایج را ببندید
 . از لایه ها ایجاد کنیمبیایید پردازش بهتری 

 .کلیک کنید  Open the layer panel Stylingروی دکمه  Layersپنل در 
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 .را انتخاب کنید Singleband pseudocolor rendererکلیک کرده و   Render، روی کشویی نوع  Layer Stylingدر پنل 
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 .کنداستایل بندی می  این رندر با استفاده از رمپ رنگی ، لایه را 
به . می یابد صاصسطح رمپ پیش فرض به رنگ قرمز سفید است که در آن حداقل رنگ به رنگ سفید اختصاص داده می شود و حداکثر مقدار در لایه به رنگ قرمز اخت  

 .  مقادیر میانی سایه ای از درون یابی خطی قرمز اختصاص داده می شود
بسیار بهتر پردازش نقشه خواهید دید که در حال حاضر . را انتخاب کنید Cumulative count cutرا گسترده کرده و گزینه  Min / Max Valueتنظیمات 

 .  است
تعیین حداقل و حداکثر مقادیر استفاده نمی شود و در نتیجه مقادیر خارجی برای ٪ از مقادیر داده تنظیم شده است ، به این معنی که از 98٪ تا 2استاندارد داده ها از محدوده 

 .تجسم بسیار نمایانتری حاصل می شود
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 .  را در لایه دیگر نیز اعمال کنیمبا استایل بندی مشابه ما می توانیم یک ظاهر . را ببندید Layer Stylingپنل 
 .  یک لایه به لایه دیگر وجود دارداستایل از یک روش آسان تر برای انتقال اما 

 .را انتخاب کنید Styles ‣ Copy Styleراست کرده و کلیک   gpw-v4-population-count-rev11_2010_2pt5_minلایه روی 
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 .را انتخاب کنید Styles ‣ Paste Styleراست کرده و کلیک   gpw-v4-population-count-rev11_2000_2pt5_minاکنون روی لایه 
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 .لایه دیگر اعمال می شوداستایل بندی شده برروی همان پارامترهای 
 .  ویژگی به ویژه هنگامی مفید است که می خواهید لایه های مختلف را با استفاده از طبقه بندی یکسان مقایسه کنیداین 

 .، می توانید بطور بصری تغییرات در جمعیت را مشاهده کنیدها با مشاهده لایه همزمان 
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 .ایجاد نقشه موضوعی از تغییرات جمعیت استتمرین ما 
 .  تفاوت بین دو لایه را محاسبه کنیم و یک شکل دیگر ایجاد کنیم که هر پیکسل نشان دهنده تغییر در جمعیت باشدبیایید 
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 .  بروید Raster ‣ Raster calculatorبه 
 .و شماره باند نامگذاری می شوند@ و پس از آن  rasterبا نام گروه ها . می توانید لایه را با دوبار کلیک روی آنها انتخاب کنید Raster bandsبخش در 

 .را به نام لایه اضافه می کنید 1باند دارند ، شما نامهای دارای شماره  1فقط رسترهای ما از آنجا که هر یک از   
  raster calculator  در این حالت ما می خواهیم یک فرمول ساده برای کم کردن جمعیت . تواند عملیات ریاضی را بر روی پیکسل های شطرنجی اعمال کندمی

 .وارد کنیم 2000از  2010
 .کلیک کنید  Outputکنار لایه ... بعد ، روی دکمه . عبارت زیر را وارد کنید  
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"gpw-v4-population-count-rev11_2010_2pt5_min@1" - "gpw-v4-population-count-rev11_2000_2pt5_min@1"  
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population_change_2010_2000.tif  برای شروع محاسبات ، تأیید را کلیک  . وارد کنیدنام فایل خروجی را به عنوان
 .کنید
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 .پنل لایه ها اضافه می شودبه  population_change_2010_2000جدید به نام پس از اتمام یک لایه 
 .تغییر دهیم تا تغییرات منفی و مثبت جمعیت بهتر دیده شوداستایل آن را بیایید   
 .کلیک کنید  Open the layer panel Stylingروی دکمه  Layersدر پنل   
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رنگی کلیک  رمپ روی کشویی . مانند گذشته و انتخاب یک سطح شیب دار رنگی واگرا استاستایل بندی مشابه یکی از گزینه ها استفاده از تکنیک 
 .را انتخاب کنید(  Spectral)طیفی کنید و سطح شیب 

 .به مقادیر زیاد اختصاص دهیدقرمزرا را به مقادیر کم و رنگ آبی را انتخاب کنید تا  Invert Color Rampکنید و کلیک  دوباره   
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 .است ، اما تفسیر آن آسان نیستپردازش خوب این یک 
 .ایجاد کنیم( High Growth)زیادو رشد (  Growth)رشد ، ( Neutral)خنثی ، ( Decline)شامل کاهش دسته گسسته  4یک نقشه بهتر با بیایید 
 .کلیک کنید(  Remove selected row(s))شدهانتخاب ( های)بر روی دکمه حذف سطر . را نگه دارید و تمام ردیف ها را انتخاب کنید Shiftکلید 
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 .تغییر دهید Discreteرا به  Interpolationحالت 
 .اکنون یک نقشه رنگی به صورت دستی ایجاد خواهیم کرد 
 .کنیدروی دکمه افزودن ارزشها به صورت دستی کلیک   
 .عنوان برچسب وارد کنیدرا به   Declineو  Valueرا به عنوان  100- 
 .این است که به تمام مقادیر کمتر از مقدار وارد شده ، رنگ آن ورودی داده می شودرمپ رنگ نحوه کار . رنگ آبی را به این دسته اختصاص دهید 
 .بوم فقط مناطقی را نشان می دهد که تغییر جمعیت منفی دارندنید که توجه ک 
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 .  را با مقادیر مناسب تکمیل کنیدرمپ رنگی 
 .کرده ایمرا به عنوان مرزهای بالاتر برای گروه های خنثی ، رشد و رشد بالا انتخاب   100000و  1000،  100به ترتیب ما 
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 .را ببندید Layer Stylingپانل تصویر پردازش شده نهایی، پس از رضایت از 
 .اکنون شما یک نقشه موضوعی جهانی برای تغییر جمعیت دارید 
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 (Clipping)رستری و برش دادن( Mosaicing)موزاییک. 7

 NASA Shuttle Radar Topographyمجموعه ( LP DAAC)فرآیندهای توزیعی فعال زمین بایگانی مرکز •

secondarc 1 ) Global SRTMMission (  داده استعنوان کاشی های ارتفاعی ارائه را به. 
 .خواهیم داشتاحتیاج  EarthNaturalاز کشورها    Countries -0 Admin به شیپ فایلما همچنین •
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N07E081.SRTMGL1.hgt.zip 

N08E079.SRTMGL1.hgt.zip 

N08E080.SRTMGL1.hgt.zip 

N08E081.SRTMGL1.hgt.zip 

N09E080.SRTMGL1.hgt.zip 

ne_10m_admin_0_countries.zip 
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QGIS را باز کرده و فایلهای بارگیری شده را در پانل مرورگر پیدا کنید  . 
.  انتخاب کنیدفایلهای تکی را را نگه دارید و تمام  Ctrlکلید . را گسترش دهید، فایلهای فشرده را جداگانه  hgt.فایلهای با فرمت  نشان دادن برای 

 .پس از انتخاب ، آنها را به بوم بکشید
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 .بارگذاری شده و در بوم نمایش داده می شوند Layersلایه جداگانه را مشاهده خواهید کرد که در پنل  11
 .به جعبه ابزار پردازش بروید. را در یک موزائیک واحد ادغام خواهیم کردجداگانه ما این کاشی های   

Processing ‣ Toolbox 
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 .  کنیدپیدا   GDAL ‣ Raster miscellaneous ‣ Merge toolادغام را از مسیر ابزار 
 .کنیدراه اندازی آن دوبار کلیک  برای 
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 .  کلیک کنید( Input layers)ورودی لایه های دکمه کنار ...، روی پنل ادغام در 
 .کنیدرا کلیک  ، ( Select All)جداگانه انتخاب همه لایه های برای 
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برای حفظ یکپارچگی داده ها ، . استintegersigned bit -16ذکر شده است ، نوع داده ورودی   detailsdataset layerهمانطور که در جزئیات لایه 
 .باید همان داده را برای لایه ادغام شده حفظ کنیم

  Int16  به عنوان نوع داده خروجی انتخاب کنیدرا. 
 Highفشرده سازی . می توانند بسیار بزرگ شوند GeoTiffفایهای فشرده نشود ، است که اگر  GeoTiffهمچنین فرمت داده خروجی پیش فرض   

Compression  به عنوان راProfile  اجرا روی . کنیدانتخاب(Run )کلیک کنید 
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 .  اضافه می شود Layersبه پنل  OUTPUTپس از اتمام پردازش ، یک لایه جدید 
 .به بالا بکشید، آن را انتخاب کرده و بقیه لایه ها صورت عدم وجود لایه در بالای در 
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 .استجداگانه ادغام شده از کاشی های ورودی ارتفاعی شامل داده های  OUTPUTخواهید دید که لایه 
 .نشان می دهد 255-0فرض فقط مقادیر پیکسل را در دامنه تصویرپیش  
 .  در نتیجه یک کنتراست پایین ارائه می شودو هستند  2371تا  14-اما داده های ما حاوی پیکسل هایی با مقادیر  

 .  تغییر دهیمتصویر پردازش شده ی بهتری آن را به بیایید 
 .کلیک کنید  Open the layer panel Stylingروی دکمه  Layersپنل در 
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این گزینه رندر . انتخاب کنیدرا  Hillshadeکلیک کنید و   Renderنوع کشوی ، روی   Layer Stylingدر پنل 
 .مناسب استارتفاعی مخصوصاً برای داده های 
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 .استمورد علاقه رسترها، برش دادن منطقه یکی دیگر از اقدامات متداول در هنگام کار با 
 .  خواهیم کردرا درمحدوده ی کشور سریلانکا کلیپ شده های ادغام آموزش ، لایه در این  

 .شده را پیدا کرده و آن را گسترش دهیدبارگیری  ne_10m_admin_0_countries.zipفایل 
 .روی بوم بکشیدرا  ne_10m_admin_0_countries.shpشیپ فایل 
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 .انتخاب کنید Layersدر پانل را  ne_10m_admin_0_countriesلایه های تازه اضافه شده 
پس از انتخاب ، روی چند . کلیک کنید  Attributesنوار ابزار در  Select Features by areaبر روی دکمه   

 .سریلانکا کلیک کنید تا آن را انتخاب کنید(  polygon)ضلعی
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 .کنیدرا باز  " پردازش"دارید و جعبه ابزار بصورت پیشفرض نگه انتخاب را همانطور که هست 
 .برای راه اندازی آن دوبار کلیک کنید. راجستجو کنید GDAL ‣ Raster extraction ‣ Clip raster by mask layerابزار
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 .را به عنوان ورودی لایه تنظیم کنید Clip Raster by Mask Layer  ،OUTPUTپنلدر 
ne_10m_admin_0_countries  شدهبه عنوان لایه ماسک انتخاب کنید و کادر انتخاب ویژگی های انتخاب را(Selected features only ) را

 .تیک بزنیدفقط 
 .باند های خروجی اختصاص دهیدبه  nodataمقادیر را به عنوان  0.0000  
 .کنیدکلیک  اجرا  روی . انتخاب کنید Profileبه عنوان را  High compressionمانند گذشته ،   
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 .اضافه می شود Layersبه پنل  OUTPUTیک لایه جدید 
 .با هم قابل مشاهده هستندزیادی های لایه در این مرحله ، ممکن است دیدن خروجی کار سخت باشد زیرا   
 .انتخاب کنیدرا  Hide All Layersدر پنل لایه ها کلیک کنید و ( Manage Map Themes)نقشه هابر روی دکمه مدیریت تم   
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 .استایل بندی کنیدمانند قبل  Hilshadeکنید وآن را با را روشن   OUTPUTفقط آخرین لایه 
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 .برای سریلانکا آماده استمجموعه آن خروجی ادغام شده و زیر ارتفاعی لایه 
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 (Terrain Data)زمینی/کار با داده های رقومی. 8
 .مفید است و اغلب در نقشه ها استفاده می شود GISتحلیلها در برای بسیاری از تجزیه و ارتفاعی یا زمینی داده های •
•QGIS  این زمینه استدارای قابلیت پردازش مناسب در. 
 .خواهیم کرداورست کار کوه در اطراف  تولید محصولات مختلف از داده های ارتفاعی مانند کانتورها ، تپه های مرتفع و غیره را مراحل این آموزش ، ما در •
 .  کار خواهیم کرد  USGSاز  GMTED2010داده های با مجموعه لذا •
 .بارگیری کرد USGS Earthexplorerداده ها را می توان از سایت این •
•GMTED (Global Multi-resolution Terrain Elevation Data ) است که نسخه جدیدتری از مجموعه داده زمینی یک مجموعه داده

 .است GTOPO30های 
 .جستجو کنیدرا  Mt. Everestمکاندر برگه معیارهای جستجو ، نام . بروید USGS Earthexplorerقسمت به •
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 .بررسی کنیدرا  GMTED2010را گسترش داده و  Digital Elevation، گروه  Data Setsدر تب 
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بروید و بخشی از مجموعه داده های موجود در معیارهای جستجوی خود را مشاهده  ( Results tab)نتایجاکنون می توانید به برگه 
 .کنید

 .  کنیدکلیک  ( Download Options)های بارگیری بر روی دکمه گزینه   
 .اگر حساب کاربری ندارید می توانید یک حساب کاربری رایگان ایجاد کنید. این مرحله باید وارد سایت شویددر 
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 .را کلیک کنید Download Optionانتخاب کرده و گزینه را  ARC SEC 30گزینه 
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 .  دارید GMTED2010N10E060_300.zipاکنون یک پرونده با نام •
 .می شودتولید و غیره  ASC  ،BIL  ،GeoTiffمانند ( رستری)شطرنجیهای مختلف فرمت در ارتفاعی های داده •
•QGIS  از طریق کتابخانه فرمتهای رستری از طیف گسترده ای ازGDAL اطلاعات . پشتیبانی می کندGMTED  به عنوان پرونده های

GeoTiff  شده استدرج شده در این بایگانی فشرده. 
 
 
 

 GMTED2010N10E060_300.zip :  داده ها•
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 . را وارد کنیدبارگیری شده  zipکلیک کرده و فایل   Layer ‣ Add Raster Layerبر روی 
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 .شده اندالگوریتم های مختلف تولید مشاهده می کنید که با فایل های مختلف زیادی 
 .استفاده خواهیم کرد 10n060e_20101117_gmted_mea300.tifبرای این آموزش از پرونده ای بنام   
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 . مشاهده خواهید کردرا  QGISارائه شده در زمینی داده های 
 .  متر در آن مکان استبرحسب پیکسل موجود در سطح زمین نشانگر ارتفاع متوسط هر 

 .دهندتر مناطقی را با ارتفاع زیاد نشان می روشن های تاریک مناطقی با ارتفاع کم را نشان می دهد و پیکسل های پیکسل 
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 .ثبت شده است E °86.9253و  N °27.9881قله اورست مربوط به مختصات ویکی پدیا در . پیدا کنیمنظر را بیایید منطقه مورد 
استفاده  ( طول ، عرض جغرافیایی)استفاده می کند ، بنابراین باید از مختصات به عنوان ( X ،Y)از مختصات در قالب  QGISتوجه داشته باشید که  

 .  کنید
 .  را بزنید Enterدهید و ، قرار  Coordinateو در بخش  QGISرا در پایین پنجره  86.9253,27.9881عدد 

 .  را بزنید Enterرا وارد کرده و   1:1000000، مقیاس  Scaleبزرگنمایی ، در قسمت برای . این نقطه به عنوان مرکز نقشه ثبت می شود
 .نمای منطقه را در اطراف هیمالیا مشاهده خواهید کردبزرگنمایی 

m
o

z
a

ff
a

re
e

_
1

9
8

7
@

y
a

h
o

o
.c

o
m

ر 
و
پ
 
ی
ر
ف
ظ
م
 
ه
م
ج
ن

  
  
  

 

mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com


 .کنیدانتخاب   Raster ‣ Extraction ‣ Clipperرا از  Clipperابزار . منطقه ی هیمالیا را جدا می کنیماکنون 
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 .بنامید  everest_gmted30.tif، پرونده خروجی خود را  Clipperدر پنجره 
 .را به صورت گسترده انتخاب کنید Clippingحالت   
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 .بروید QGISرا باز نگه دارید و به پنجره اصلی  Clipperپنجره 
 .کل صفحه را بپوشاندرا بکشید که  مستطیلی دکمه سمت چپ ماوس خود را نگه دارید و   
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 . دیدرا خواهید خود حاصل از انتخاب ، مختصات خودكار  Clipperاکنون در پنجره 
 .کلیک کنیدرا   OK، تیک خورده باشد و سپس  Load into canvas when finishedگزینه حاصل کنید که  اطمینان 
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 .مشاهده خواهید کرد QGISپس از اتمام مراحل ، یک لایه جدید بارگذاری شده در 
 .  پوشش می دهداورست را این لایه فقط ناحیه اطراف کوه   

 .کنیدانتخاب   Raster ‣ Extraction ‣ Contourکانتور را از . تراز هستیم/خطوط ارتفاعیآماده تولید اکنون ما 
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 .ورودی انتخاب کنیدفایل به عنوان را  everest_gmted30در پنل خطوط تراز، 
 .کنیدنامگذاری   everest_countours.shpعنوانرا برای خطوط کانتور به  Outputفایل 

 . کردتولید خواهیم  ( Interval between contour lines)متر را به عنوان فواصل  100ترازخطوط ما 
را   OK. به عنوان ویژگی هر خط کانتور ثبت شود( ELEV)ارتفاعرا بررسی کنید تا مقدار  Attribute nameگزینه همچنین  
 .کنیدکلیک  
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 . بارگذاری شده در بوم را مشاهده خواهید کردتراز   خطوطپس از اتمام پردازش ، 
 .  خط، تراز ارتفاعی یکسانی  را نمایش می دهدهمه نقاط در امتداد یک . خط در این لایه یک ارتفاع خاص را نشان می دهدهر 

 .خطوط نزدیکتر باشند ، شیب تندتر استهرچه 
 .را انتخاب کنید Open Attribute Tableلایه کانتورها راست کلیک کرده و روی 
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 . استمتر به این ارتفاع . است ELEVدارای یک ویژگی به نام عارضه ی خطی خواهید دید که هر 
 . مرتب کردن مقادیر به ترتیب نزولی ، چند بار روی سربرگ ستون کلیک کنیدبرای 
 .می دهدقله اورست ، نشان یعنی ، اینجا خطی را مشاهده می کنید که بالاترین ارتفاع را در داده های در 
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 .کلیک کنید  Zoom to selectionرا انتخاب کنید و بر روی دکمه بالایی ردیف 
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 . بروید QGISبه پنجره اصلی 
 . کانتور انتخاب شده را به رنگ زرد برجسته خواهید دیدخط  

 .های ماستارتفاع در مجموعه داده این منطقه، بالاترین 
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 .  کنیمفایل رستری ایجاد  از ( hillshade)تپه اییک نقشه بیاید حالا 
 .انتخاب کنیدرا  Raster ‣ Analysis ‣ DEM (Terrain Models)برای این کار

m
o

z
a

ff
a

re
e

_
1

9
8

7
@

y
a

h
o

o
.c

o
m

ر 
و
پ
 
ی
ر
ف
ظ
م
 
ه
م
ج
ن

  
  
  

 

mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com


 .  انتخاب کنیدورودی را به عنوان  everest_gmted30فایل ، DEM (Terrain Models )پنل در 
  Output  را به عنوانeverest_hillshade.tif بنامید. 
  Hillshade را به عنوان حالت انتخاب کنید  . 

 . به صورت پیشفرض باقی بگذاریدگزینه های دیگر را همه  
 .کلیک کنیدرا   OKتیک خورده باشد و  Load into canvas when finishedحاصل کنید که گزینه اطمینان 
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 . مشاهده خواهید کرد QGISبارگذاری شده در بوم یک فایل رستری دیگر پس از اتمام فرآیند ، 
کلیک راست کرده و   everest_hillshadeبزرگنمایی کنید ، بر روی لایه  Mt.Everestنزدیکی منطقه اگر می خواهید در 

Zoom to Layer Extent را انتخاب کنید. 
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 .داشتخواهید دید وسیع بر فایل رستری از تپه اورست اکنون 
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 .مشاهده کنید Google Earthذخیره کرده و آن را در  KMLکانتور به عنوان لایه  همچنین می توانید 
 .را انتخاب کنید... Save asو گزینه راست کانتورها، کلیک روی لایه  برای این بر 
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 . انتخاب کنیدرا ( Keyhole Markup Language[)KML]فرمت
 .کلیک کنیدرا   OKنامگذاری کرده و  contours.kmlبه عنوان خروجی را 
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 .باز شود Google Earthتا در خود بروید و روی آن دوبار کلیک کنید هارد دیسک به پرونده خروجی موجود در 
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 WMS( Web Map Service)های داده با کار .9
 .  داریدنیاز ای مرجع  لایه های داده خود به نقشه اصلی برای اغلب •
 .هستندقابل استفاده  GISاز سازمان ها مجموعه داده ها را بصورت آنلاین منتشر می کنند که به راحتی در بسیاری •
بهتر برای استفاده از لایه شود که انتخابی نامیده می ( ای وبسرویس نقشه ) WMSاستاندارد محبوب برای انتشار نقشه ها بصورت آنلاین یک •

 .دسترسی پیدا می کنید GISمجموعه ای غنی از داده های نقشه ای در ها ، به بارگیری داده نیاز به که بدون های مرجع است  
 .را بارگذاری خواهیم کرد USGSشده توسط منتشر  جهاندر این آموزش ، لایه هایی از ذخایر مهم معدنی •

• Major mineral deposits of the world 
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QGIS  را باز کنید و بهLayer ‣ Add WMS Layer... بروید. 
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 .کلیک کنید  New، روی  Layersدر تب 
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 .  است WMSلایه نیست بلکه نام سرویس ارائه دهنده لایه این نام . کنیداتصال خود را نامگذاری  
 .  سرویس واحد معمولًا چندین لایه ارائه می دهد که می توانند به پروژه شما اضافه شوندیک 

URL  که برای دسترسی به یک لایهWMS  ، نیاز داریدGetCapabilities نامیده می شود. 
مختلف را برمی  متادیتاهای دسترسی پیدا می کنید ، لیستی از لایه های موجود به همراه  WMSبه سرور  URLهنگامی که با این پارامتر در  

 .گرداند
عنوان به را   GetCapabilitiesنشانی اینترنتی و  MRDATA USGSدر این حالت ، اتصال را به عنوان  

https://mrdata.usgs.gov/services/ofr20051294  
 تأیید را کلیک کنید. کنیدنامگذاری  
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به شناسه های مختلفی که در کنار لایه ها لیست شده اند ، توجه  . کلیک کنید تا لیست لایه های موجود دریافت شود  Connectسپس بر روی دکمه 
و + اگر همه لایه ها را نمی خواهید ، می توانید با کلیک بر روی آیکن . بدین معنی است که می توانید نقشه ای از همه لایه ها تهیه کنید ID 0. کنید

 .را انتخاب کنید 0برای این آموزش لایه . انتخاب لایه مورد علاقه ، لیست را گسترش دهید
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 در بخشImage encoding ،استفاده نحوه ی یک را انتخاب می کنید به اینکه کدام تصویر اهمیت زیادی دارند و فرمتهای . شما باید فرمت تصویر را انتخاب کنید

 .داردشما بستگی 
 ذکر چند نکته حائزاهمیت استاینجا در  : 
 :کیفیت. 1
PNG  استکاهش کیفیت تصویر فشرده شده بدون  تصویری یک فرمت. 
  JPEG  استبا کیفیت کم یک فرمت فشرده سازی. 
  TIFF   کیفیت کمی داردهم. 
 بدان معناست که کیفیت تصاویر اینPNG  در مقایسه باJPEG اگر هدف اصلی شما چاپ نقشه است ، از . بهتر خواهد بودPNG   کنیداستفاده. 
اگر از لایه موجود در پروژه خود . هستند ، بارگذاری آنها به مدت زمان بیشتری طول می کشدبزرگتری فشرده نشده و در نتیجه در اندازه  PNGاز آنجا که تصاویر : سرعت. 2

 .کنیداستفاده   JPEGدارید ، از زیاد به عنوان یک لایه مرجع استفاده می کنید و نیاز به زوم 
پشتیبانی نمی کنند ، بنابراین باید  TIFFاز اکثر قالب ها پشتیبانی می کند ، اما اگر برنامه های وب را توسعه می دهید ، مرورگرها معمولاً از  QGIS: مشتریپشتیبانی . 3

 .فرمت دیگری را انتخاب کنید
 .معمولاً انتخاب بهتری است JPEG، رستری برای لایه های . نتایج بهتری خواهد داد PNGهستند ، برداری اگر لایه های شما در درجه اول : دادهنوع . 4

 .کلیک کنید  Addدر صورت تمایل نام لایه را تغییر داده و بر روی . را به عنوان فرمت انتخاب کنید JPEGاین آموزش برای 
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 WMSنحوه کار سرویس . حرکت کنید/ می توانید درست مانند هر لایه دیگر بزرگنمایی . را مشاهده خواهید کرد QGISلایه بارگذاری شده در بوم 

را به سرور ارسال می کند و سرور تصویری را برای آن شما   viewportانجام می دهید ، مختصات را به این صورت است که هر بار که بزرگنمایی 
همچنین ، از آنجا که . ایجاد می شودلحظه تأخیر بنابراین بعد از بزرگنمایی تصویر برای منطقه چند . منظره ایجاد می کند و آن را به مشتری باز می گرداند

 .برداری وجود ندارد/ داده هایی که می بینید تصویری است ، راهی برای پرس و جو در مورد خصوصیات مانند یک لایه معمولی 
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را  Propertiesروی لایه راست کلیک کرده و . لایه را مشاهده کنیددرباره ( متا دیتا )با این حال ، می توانید برخی از ابرداده 
 .انتخاب کنید
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 .بروید  Informationو لایه ها می توانید به برگه  WMSبرای کسب اطلاعات بیشتر در مورد سرویس 
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 (Projections)مرجع کردنزمین . 10

اما درک صحیح مفاهیم و . زیادی می شونددردسر باعث  GISمعمولاً هنگام کار با داده های  -( CRS)مختصات یا سیستم مرجع  -ها کردن نقشه زمین مرجع  •
 .  آسان تر می کندکار با ژئورفرنسیگ را دسترسی به ابزارهای مناسب ،  

 .دادمورد بررسی قرار خواهیم رستری را برای داده های وکتوری و  QGISکردن در این آموزش ، چگونگی عملکرد زمین مرجع  در •
 :  داده ها•
•Earth Natural  دارای لایهCountries  -0 Admin  کنیدرا بارگیری  لایه ی کشورها . است  . 

• ne_10m_admin_0_countries.zip 

• minisc_gb.zip (بریتانیا)  

•QGIS به . را باز کنیدLayer ‣ Add Layer ‣ Add Vector Layer... بروید. m
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 .شده بروید و روی باز کردن کلیک کنیدبارگیری  ne_10m_admin_0_countries.zipپرونده به 
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را  Yو  Xبر روی نقشه ، مختصات نما با حرکت مکان . را مشاهده خواهید کرد Coordinate، برچسب  QGISدر پایین پنجره 
 .در آن مکان به شما نشان می دهد

 .فعلی پروژه است(  CRS)کد پروجکشن این  . مشاهده خواهید کردرا  EPSG:4326در گوشه پایین سمت راست   
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 .لایه مطابقت نداشته باشد CRSپروژه ممکن است با  CRSخواهید کرد ، بعداً مشاهده 
کلیک راست کرده و   ne_10m_admin_0_countriesروی لایه . نگاه کنیممتادیتا لایه ، می توانیم به یک برای تعیین پروجکشن  

Properties را انتخاب کنید. 
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مرجع فضایی سیستم در پایین ، تعریف . را گسترش دهید Propertiesبخش . بروید Layer Propertiesپنل در  Metadataبه تب 
 .خواهید کردمشاهده   Layer Spatial Reference Systemرا در لایه 

 .است   .format 4PROJقالباین تعریف در  
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کنیم ،  را دوباره پروجکشنکل لایه به جای اینکه  . نام دارد Re-Projectionاین عمل . لایه را تغییر دهیم حال ببینیم چگونه می توانیم پروجکشن
کرده و روی  استفاده    single clickابزار یا   Select features by areaگزینهاز  . کنیممی توانیم برخی از ویژگی ها را از لایه پروجکشن  

 .آن را انتخاب کنیدو گزینه ایالات متحده کلیک کنید 
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 .را انتخاب کنید Save Asراست کرده و گزینه کلیک    ne_10m_admin_0_countriesروی لایه 
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 Saveهمچنین جعبه . بنامید united_states.shpلایه خروجی را به عنوان ، ...Save vector layer asدرپنل 

only selected features   با این کار اطمینان حاصل می شود که فقط ویژگی انتخاب شده دوباره پیش بینی و . تیک کنیدرا
 .صادر می شود

 .کلیک کنید  Select CRSبر روی دکمه . را برای لایه انتخاب می کنیمجدید بعد ، پروجکشن   
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نتایج را مرور کنید و  . ، در کادر جستجوی فیلتر ، آمریکای شمالی را وارد کنیدCoordinate Reference System Selectorپنل در 
 .را بزنید OKانتخاب کنید و را   North_America_Albers_Equal_Area_Conic (EPSG:102008)گزینه 
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CRS  جدید انتخاب شده در لایهSave vector as  ...تأیید را کلیک کنید. را مشاهده خواهید کرد 
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 .را کاملاً پوشانده  ne_10m_admin_0_countriesلایه روی   united_statesمتوجه می شوید که لایه جدید شده، پس از بارگیری لایه پروجکشن 
 .  دارد On-the-fly CRS transformationیک ویژگی به نام  QGISامر به این دلیل است که این 
را  CRSکسب اطلاعات بیشتر ، بگذارید گزینه برای  . استداده قرار   EPSG:4326را در کنار  OTFاکنون کلمات  QGISپایین سمت راست در پروجکشن متن 
 .بررسی کنیم QGISدر 
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 .بروید Settings ‣ Optionsبه منوی 
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 on‘های مختلف باشند ، پیش فرض به طور خودکار  CRSاگر لایه ها دارای . بروید CRSگزینه ها به برگه گفتگوی  در کادر  

the fly’   این بدان معناست که وقتی . فعال می کندراQGIS  تشخیص دهد که شما لایه هایی باCRS  مختلف بارگذاری کرده
 کلیک کنیدرا   OK. می کند واحد باز  CRSدر اید ، به طور خودکار آنها را 
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بر روی متن فعلی . اتفاقی می افتدببینید چه و کنید خاموش  را   On-the-fly CRS transformationگزینه ی 
CRS در گوشه پایین سمت راست کلیک کنید. 
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 .را بزنید OKعلامت بزنید و را "  on the fly "، کادر فعال سازی  Project Propertiesدر کادر گفتگوی 
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به  CRS Projectدلیل این امر این است که . بین رفته استجهان از ، خواهید دید که نقشه  QGISدر پنجره اصلی 
North_America_Albers_Equal_Area_Conic  است و مختصات و مقیاس اکنون متفاوت مرجع یافته تغییر

 .را انتخاب کنید Zoom to Layerراست کلیک کرده و  united_statesروی لایه . هستند
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 .شده خواهید دیدسیستم مرجع انتخاب اکنون ایالات متحده را در 
متفاوت از لایه سیستم مختصات بوم ظاهر نمی شوند زیرا در یک روی  ne_10m_admin_0_countriesتوجه کنید که ویژگی های  

united_states قرار دارند. 
 .برای بقیه آموزش فعال کنیدرا   Enable ‘on the fly’ CRS transformationبرگردید و گزینه  Project Propertiesپنل به  
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 .کنیماضافه  پروژه رستری به لایه می خواهیم یک حالا •
 .برویدرا استخراج کرده اید ،  minisc_gb.zipبه فهرست راهنمایی که فایل  •
 .  است ، پیدا کنید tifفایلهای که حاوی را    RGB_TIF_COMPRESSEDپوشه  •
 .GeoTIFFساده هستند ، نه فایلهای  TIFفایلهای  tifخواهید شد که فایلهای تصویری متوجه •
 .زمین مرجع کردن ندارنداین بدان معناست که آنها هیچ اطلاعاتی برای  •
نوع  2یک موقعیت جغرافیایی شامل . ، باید آنها را جغرافیایی کنید( GIS)برای استفاده از این تصاویر در یک سیستم اطلاعات جغرافیایی  •

 . استسیستم مرجع مختصات ابعاد تصویر و  -اطلاعات 
 .  دارند jgw.یا   tfw.مانند پسوندهایی طور معمول به •
 .قرار دارند georeferencing_filesیک پوشه جداگانه با نام در  MiniScale rasterدر .tfwهای پرونده •
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متنی ساده فایلهای .  tfwفایلهای . بروید georeferencing_filesدر پرونده های  ESRI_TFW_FILESبه پوشه 
 .باز کنیدمتنی را در یک ویرایشگر آنها یکی از . هستند
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می یک فایل را نشان ، هر خط اطلاعاتی درباره شد داده توضیح همانطور که . خط با تعدادی شماره هستند 6دارای فایلهای جهانی 
همراه نیستند و شاید شما مجبور باشید با استفاده از جهانی های فایل است زیرا برخی از داده ها با مطلب مفید دانستن این . دهد

 .کنیدایجاد  اطلاعات ارائه شده ، آنها را با استفاده 
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Line 1: A: pixel size in the x-direction in map units/pixel  

Line 2: D: rotation about y-axis 

Line 3: B: rotation about x-axis  

Line 4: E: pixel size in the y-direction in map units 

Line 5: C: x-coordinate of the center of the upper left pixel  

Line 6: F: y-coordinate of the center of the upper left pixel  
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در پوشه  georeferencing_filesاز پوشه را   MiniScale_(standard)_R17.tfwپرونده 
RGB_TIF_COMPRESSED کپی کنید. 

 .استفاده کنداین اطلاعات می تواند از  QGISدارند و مسیرقرار همان در .  tifو .  tfwبه این ترتیب فایلهای  
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 .بروید Layer ‣ Add Layer ‣ Add Raster Layer، به  QGISپنجره اصلی در 
 .کنید  Openو   MiniScale_(standard)_R17.tifفایل بر روی 
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جست و جو  را  british national، (Coordinate Reference System Selector)مختصاتکادر گفتگوی سیستم مرجع در  
 .کنیدتأیید را کلیک  . را انتخاب کنید OSGB 1936 / British National Grid (EPSG:27700)کنید و 
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 .بر روی آن راست کلیک کرده و بزرگنمایی را برای لایه انتخاب کنید، MiniScale_(standard)_R17پس از بارگیری لایه 
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 .  قرار گرفته است ne_10m_admin_0_countriesبرداربالای لایه خواهید دید که لایه رستری در 
درسیستم  پویا به صورت  MiniScale_(standard)_R17 کرده ایم ، لایه فعال   EPSG:4326را با  OTFکه از آنجایی  

EPSG:4326  مانند لایه دیگر نشان داده می شودسیستم مختصات دوباره مورد استفاده قرار می گیرد و در همان. 
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ن (QGIS3)زمین مرجع کردن نقشه ها در فایل های رستری. 11

.  نیاز به زمین مرجع سازی دارندGISبیشتر پروژه های •
.فرآیند اختصاص مختصات دنیای واقعی به هر پیکسل یک نقشه ی شطرنجی رستری است( Georeferencing)زمین مرجع کردن•
.درچند ویژگی قابل شناسایی در تصویر یا نقشهGPSجمع آوری مختصات با یک دستگاه -بسیاری از اوقات این مختصات با انجام تحقیقات میدانی بدست می آیند •
با استفاده . ه تهیه کنیدنقشدر بعضی موارد ، مثلا جایی که به دنبال دیجیتالی کردن نقشه های اسکن شده هستید ، می توانید مختصات را از نشانه های موجود در خود•

.، تصویر چرخیده شده در سیستم مختصات انتخاب شده قرار خواهد گرفت( نقاط کنترل زمینی)ها GCPاز مختصات نمونه یا 
ستم مختصات از زمانی که سی. را برای دستیابی به نقشه ی ژئورفرنس با دقت بالا بررسی خواهیم کردQGISدر این آموزش مفاهیم ، استراتژی ها و ابزارهای موجود در •

. نقشه رستری ندارید ازآموزش زمین مرجع کردن تصاویر هوایی استقاده کنید
southern_india.jpg_1870: داده ها•

ی به این معنی که در حال حاضر بخش-این یک افزونه اصلی است . انجام می شودGeoreferencer GDALاز طریق افزونه QGISزمین مرجع کردن در •
. شما فقط باید آن را فعال کنید. شماستسیستم QGISفرایند نصب از 

‣ Pluginsافزونه ها بروید به • Manage and Install Plugins  وGeoreferencer GDAL plugin   کنیدرا در فعال .

mailto:mozaffaree_1987@yahoo.com
http://www.qgistutorials.com/downloads/1870_southern-india.jpg


.کلیک کنیدRaster ‣Georeferencerبرای باز کردن افزونه روی . نصب شده استRasterافزونه در منوی 
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دول نشان داده قسمت فوقانی که تصویر نمایش داده می شود و قسمت پایین که در آن یک ج. بخش تقسیم می شود2پنجره افزونه به 
.می شوددر آن ظاهر های شما GCPاست و شده 
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‣ Fileبه . خود را باز خواهیم کردJPGاکنون تصویر  Open Raster بروید.
.کلیک کنیدOpenو بر روی بروید نقشه اسکن شده از بارگیری شده به مسیر تصویر 
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.  انتخاب کنیدمختصات رستری را در صفحه بعدی ، از شما خواسته می شود سیستم مرجع 
در آن وجود ندارد ، بنابراین می توانید بر رویمختصاتی ساده است و هیچ سیستم مرجع JPEGمنبع ما یک فایل تصویر 

Cancelکلیک کنید.
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وانید از برای کسب اطلاعات بیشتر در مورد نقشه می ت. خواهید دید که تصویر در قسمت بالای صفحه بارگیری می شود
zoom/pan  نوار ابزار استفاده کنیددر.
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نشانه هایی را با نگ خطوط شبکه هماهاگر از نزدیک نگاه کنید ، . این نقشه اختصاص دهیمبه چند نقطه در اکنون باید مختصات 
.عرض جغرافیایی هستندطول و اینها خطوط . مشاهده خواهید کرد
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. تعریف کنیمانتقال را ، باید تنظیمات ( GCP)قبل از شروع اضافه کردن نقاط کنترل زمینی 
‣ Settingsبه  Transformation settings بروید.
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.  انتخاب کنید( Polynomial 2)ایرا به عنوان چند جمله Transformation، نوع Transformپنل تنظیمات در 
.کلیک کنیدTarget SRSدر کنار ( انتخاب)CRSدکمه روی 
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ندارد ، بنابراین جود و ( سطح مبنا)داتوم هیچ اطلاعاتی از اما . و عرض جغرافیایی قرار دارندطول نگاهی به تصویر نقشه ، مختصات با 
. انتخاب کنیمباید یک مورد مناسب را 

.خوبی به ما بدهدنتایج  Everest 1830 datumقدیمی است ، می توانیم شرط کنیم که نقشه هند و کاملًا آنجا که از 
. (EPSG:4042)دادهبا قدیمی ترین تعریف از CRSو انتخاب everestجستجوی 
تأیید کنید
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raster 1870خروجی خود را به عنوان_southern_india_modified.tifنامگذاری کنید  .
LZW اطمینان حاصل کنید که گزینه . سازی انتخاب کنیدفرمت فشرده را به عنوانLoad in QGIS تیک هنگام انجام کار

.را کلیک کنید OKسپس . خورده است
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-ground)نقاط درست زمینیتقاطع خطوط شبکه به عنوان . را شروع کنیم( GCP)اکنون می توانیم اضافه کردن نقاط کنترل زمینی 

truth )  همانطور که خطوط شبکه برچسب خورده اند ، می توانیم مختصات . کندبه ما کمک میX وY نقاط را با استفاده از آنها
روی افزودن نقطه کلیک کنید. تعیین کنیم
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.کنیدکلیک  را   OK. عرض جغرافیایی= Yطول جغرافیایی و = Xبه یاد داشته باشید که . در پنجره بازشو ، مختصات را وارد کنید

m
o

z
a

ff
a
re

e
_

1
9

8
7
@

y
a
h

o
o

.c
o

m
ور

ی پ
فر

مظ
ه 

جم
ن

mailto:mozaffaree_1987@yahoo.com


.نقطه ی کنترل زمینی شماستاکنون دارای ردیفی با جزئیات مربوط به اولین GCPمتوجه می شوید که جدول 
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، ینی بیشترباشد تعداد نقاط کنترل زمهرچه . های بیشتری را اضافه کنید که کل تصویر را پوشش می دهدGCPبه طور مشابه ، 
.نیاز دارد6GCPبه حداقل  Polynomial 2تبدیل . تصویر دقیق تری در مختصات هدف ثبت می شود
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و dX  ،dYها اکنون دارای مقادیر خطای غیر صفر GCPنیاز برای تبدیل ، متوجه می شوید که نقاط مورد پس از اضافه کردن حداقل 
Residualاگر یک . هستندGCP خاص دارای مقدار خطای غیرمعمول بالایی باشد ، این به معنای خطای انسانی در وارد کردن مقادیر
.را حذف کرده و دوباره آن را ضبط کنیدGCPبنابراین می توانید آن . مختصات است

.با کلیک کردن روی سلول در هر قسمت ویرایش کنیدGCPهمچنین می توانید مقادیر مختصات را در جدول 
‣ Fileشدید ، به راضی GCPکه از هنگامی   Start georeferencingبروید  .

.آغاز می کندنقاط هدف و GCPرا با استفاده از چرخاندن تصویر کار روند این  
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زمین مرجع کردن هم اکنون . را مشاهده خواهید کردQGISبارگذاری شده در georeferencedپس از اتمام فرآیند ، لایه 
.کامل است
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؟ما درست استgeoreferencingمی توانیم بررسی کنیم که شما این است که ببینید چگونه تمرین خوب برای تأیید کار یک 
با هم بارگیری کرده و آنها را Natural Earthرا از یک منبع قابل اعتماد مانند مجموعه داده های مرزها shapefileمی توانید مورد، در این 
امتحان پارامترهای انتقال و غییر بیشتر ، تنقاط کنترل گرفتن داردکه با  وجود خطای کمی  . دارندمطابقت متوجه خواهید شد که آنها بسیار . کنیدمقایسه  

.بهبود دادآن را توان نقطه ی مبنا می 
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 ( (QGIS3هواییمرجع کردن تصاویر زمین . 12
این روش شامل . پوشش دادیم  QGISمبانی فرایند زمین مرجع کردن را در ما  " رستریزمین مرجع کردن نقشه ها در فایل های : مرجعزمین _مبانی "آموزش در •

 .  وارد کردن آنها به صورت دستی توسط نقاط کنترل بودو خواندن مختصات از نقشه اسکن شده 
شما می توانید از منابع حالت، در این . است مختصات چاپ نشده در نقشه خودداشته باشید ، یا می خواهید یک تصویر را زمین مرجع کنیدممکن اوقات بسیاری •

 .  در این آموزش ، شما نحوه استفاده از منابع داده باز موجود در فرایند زمین مرجع را یاد خواهید گرفت. اطلاعات دیگری به عنوان ورودی استفاده کنید
 :  داده ها•
 .زمین مرجع خواهیم کرد OpenStreetMapما داده های حاصل از تصویر برداری بالون با وضوح بالا را با استفاده از مختصات مرجع •
•washingtonsquarepark.jpg-newyorkcity 
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بررررای گررررفت مختصررررات بررررای زمررررین مرجرررع کرررردن از یررررک نقشررره پایرررره از 
OpenStreetMap اسررتفاده خررواهیم کرررد .QGIS3  بررا

اینهرررا ملاًرررولا  بررره . پشرررتیبانی داخلاررری لایررره هرررای مررروزاییکی  رررراه اسرررت
شرررناخته مررری شررروند زیررررا برررا اسرررتفاده از  ''XYZعنررروان لایررره هرررای 

روی یرک شربکه  (zتایلاهرای نقشره ای جداگانره بررای هرر سر   زو  
 .  ساخته می شوند ( x ، yمختصات 

 XYZ Tilesرا تحرت  OpenStreetMapمری توانیرد لایره 
 .در صفحه مرورگربیابید

پرررر  از برررارگ ی ، برررره سیسرررتم مرجررررع . لایررره را برررره برررو  اصررررلای بکشرررید 
(CRS )لایه در بخش پایین سمت راست توجه کنید. 
تنظریم   EPSG 3857 Pseudo Mercatorبه عنوان  

توجه به آن، از این جهت مهم است زیرا مختصراتی کره مرا . شده است
 CRSاز ایرن لایرره برررای زمرین مرجررع کررردن اسرتفاده مرری کنرریم در ایررن 

 .خواهد بود

http://www.qgistutorials.com/downloads/newyorkcity-washingtonsquarepark.jpg
http://www.qgistutorials.com/downloads/newyorkcity-washingtonsquarepark.jpg
http://www.qgistutorials.com/downloads/newyorkcity-washingtonsquarepark.jpg
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.  زو  کنید/ می توانید این مکان را در نقشه بزرگنًایی . پارک ، نیویورک استاسکوئر واشنگت هستیم مربوط به حال زمین مرجع کردن در تصویری که ما 
 .  و ممکن است عًلای نباشدزمانبراست اما این 
 .جستجوی مکان دقیق استبرای   OpenStreetMap (OSM)راه ساده تر استفاده از افزونه یک 

 .  کنیدرا از افزونه ها نصب   OSM Place Searchافزونه  
Plugins ‣ Manage and install plugins ‣ All  

 .  تنظیًات تایید کرده ایدهای آزمایشی را نیز در زیر  ه ی افزونه این افزونه را در نتایج جستجو نمی بینید ، م ًئن شوید که اگر 
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 ....  را مشاهده می کنید  OSM Place Searchپ  از نصب افزونه ، صفحه جدیدی به نا  
 . را کلایک کنید <-انجا  و  ..Name contains را در  Washington Square Parkجستجوی 
 .نتیجه صحی  را انتخاب کرده و روی دکًه زو  کلایک کنید. نتایج ظاهر می شودبا پنل دید که نا  مکان م ابق خواهید 
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اکنون می توانید پانل . حاوی نقاط دیدنی است که می توانیم از تصویر شناسایی کنیمکه را مشاهده خواهید کرد  ای آشنا نقشه 
 .را ببندید OSMجستجوی مکان 

 .باز کنید View ‣ Panels ‣ OSM Place Searchمی توانید آن را از داشتید، اگر دوباره به آن احتیاج   
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 . کنیماکنون زمان آن فرا رسیده است که شروع به زمین مرجع  
  Georeferencer از راRaster ‣ Georeferencer ‣ Georeferencer راه اندازی کنید. 
 .کنیدرا از افزونه ها فلاال   Georeferencer GDALمشاهده نکردید ، باید افزونه را اگر آن   

Plugins ‣ Manage and install Plugins ‣ Installed 
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  Openبارگ ی شده بروید و روی  JPGبه پرونده . بروید File ‣ Open Raster، به  Georeferencerدر پنجره 
 .کلایک کنید
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 . انتخاب کنیدمختصات را در صفحه بلادی ، از شما خواسته می شود سیستم مرجع 
در آن وجود ندارد ، بنابراین می توانید بر روی مختصاتی ساده است و هیچ سیستم مرجع  JPEGمنبع ما یک فایل تصویر 

Cancel  کلایک کنید. 
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به . را تلاریف کنیم Transformationتنظیًات انتقال ، باید ( GCP)قبل از شروع اضافه کردن نقاط کنترل زمینی 
Settings ‣ Transformation settings  بروید. 
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 .انتخاب کنید( Polynomial 2)ایرا به عنوان چند جملاه  Transformation، نوع  Transformپنل تنظیًات در 
می توانید . تنظیم کنید Target CRS، بنابراین آن را به عنوان است   EPSG 3857 Pseudo Mercatorکه قبلا  نیز اشاره شد ، نقشه پایه ما در  ان ور  

 .کنیدانتخاب   Compressionرا به عنوان  LZWرا به صورت پیش فرض بگذارید و  Outputفایل خروجی نا  
  Use 0 for transparency when needed  را تیک کنید  . 

 کنیدرا کلایک    OK. استتیک شده هنگا  انجا  کار  Load in QGISحاصل کنید که گزینه اطًینان 
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روی تصویر انتخاب  باشد را  راحتی قابل شناسایی که به در نوار ابزار کلایک کنید و یک مکان   Add Pointاکنون بر روی دکًه 
 .گوشه ها ، تقاطع ها ، ق ب ها و غ ه نقاط کنترل خوبی دارند. کنید
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پ  از کلایک روی تصویر در یک مکان کنترل ، یک پنجره بازشو را مشاهده خواهید کرد که از شما می خواهد مختصات نقشه را وارد  
 .کنیدکلایک     From map canvasبر روی دکًه . کنید
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 . صورت می گ دروی بو  نقشه به طور خودکار پ  از کلایک بر مختصات .  ان مکان را در لایه مرجع پیدا کنید و روی نق ه دقیق کلایک کنید
Ok  نق ه را بر روی تصویر انتخاب کنید و مختصات آنها را از لایه مرجع اضافه کنید 6را کلایک کنید به  ین ترتیب ، حداقل. 
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 dXها اکنون دارای مقادیر خ ای غ  صفر  GCPنیاز برای تبدیل ، متوجه می شوید که شش نق ه مورد پ  از اضافه کردن حداقل 

 ،dY  وResidual هستند. 
خاص دارای مقدار خ ای غ ملاًول بالایی باشد ، این به ملانای خ ای انسانی در وارد کردن مقادیر مختصات  GCPاگر یک   

 .کنیدضبط  را حذف کرده و دوباره  GCPبنابراین می توانید آن . است
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 . بروید  File ‣ Start georeferencingبه شدید ، راضی  GCPازنتایج هنگامی که 
 .آغاز می کندرسترهدف و ایجاد  GCPرا با استفاده از چرخاندن تصویر کار روند این  
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خوبی پیش مراحل به اگر  ه . را مشاهده خواهید کرد QGISبارگذاری شده در  georeferencedپ  از اتما  فرآیند ، لایه 
 .گرفته استروی هم قرار  لایه ها ی نقشه و عک  بخوبی بر رفت ، خواهید دید که 
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 Propertiesبر روی لایه تصویر راست کلایک کرده و . بهتر به نظر برسد ، اجازه دهید مرز سفید را حذف کنیمظاهرکار برای اینکه 
 .را انتخاب کنید

m
o

z
a

ff
a

re
e

_
1

9
8

7
@

y
a

h
o

o
.c

o
m

ر 
و
پ
 
ی
ر
ف
ظ
م
 
ه
م
ج
ن

  
  
  

 

mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com


 .را بزنید OKکنید و اضافه    Additional no data valueرا به عنوان  255. بروید  Transparencyبه برگه 
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 .شده است ، خواهید دیدنقشه پایه را پوشانده روی لایه خوبی زمین مرجع شده و اکنون تصویر جغرافیایی خود را که به 
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 نقشه ( Digitizing)سازی رقومی . 13

شطرنجی رستری های داده در رقومی سازی  GISغالباً مقدار زیادی از زمان . باید انجام دهد GISاز رایج ترین کارهایی است که یک متخصص یکی رقومی سازی •
 .کندکه در تجزیه و تحلیل خود از آنها استفاده می  کند  صرف می شود تا لایه های برداری را ایجاد  

•  QGIS  است که در این آموزش به بررسی آنها خواهیم پرداختقدرتمندش ویرایش در صفحه نمایش و دارای قابلیت های رقومی سازی. 
 :  داده ها•
 .و جزایر چاتهام فراهم می کندنیوزلند برای را   1:50,000مقیاس در نقشه های توپوگرافی ( LINZ)اطلاعات زمین نیوزیلند •

•clip.tif-02-1_GeoTifv24BX 
 .کلیک کنید  Openرا پیدا کرده و روی  BX24_GeoTifv1-02.tifلایه ی   Layer ‣ Add Raster Layerدر•
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 . زمانبر استتصویر کمی ارائه ، نقشه هنگام بزرگنمایی متوجه شوید که است و ممکن است ( رستری)فایل بزرگ شطرنجیاین یک 
QGIS  استفاده از سریعترتصاویر با یک راه حل ساده برای بارگذاریImage Pyramids  می دهدارائه. 

  QGIS  کندهای از پیش رندر شده را با وضوح مختلف ایجاد می  تایل. 
 .را انتخاب کنید Propertiesراست کرده و کلیک    BX24_GeoTifv1-02روی لایه   
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گزینه های . را انتخاب کنید Resolutionsرا نگه دارید و تمام رزولوشن های ارائه شده در پنل  Ctrlکلید . را انتخاب کنید Pyramidsبرگه 
 .کلیک کنید  OKپس از اتمام مراحل ، روی . کنیدکلیک  ( Build pyramids)هرمدیگر را به صورت پیش فرض بگذارید و بر روی ساخت 

m
o

z
a

ff
a

re
e

_
1

9
8

7
@

y
a

h
o

o
.c

o
m

ر 
و
پ
 
ی
ر
ف
ظ
م
 
ه
م
ج
ن

  
  
  

 

mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com


این . استفاده کنید Christchurchدر  Hagley Parkبرای یافتن منطقه  Zoom، از ابزار  QGISدر پنجره اصلی 
 . آن را رقومی خواهیم کرداست که ما پارکی 
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 ...بروید   Settings ‣ Optionsبه . سازی را تنظیم کنیمرقومی قبل از شروع ، باید گزینه های پیش فرض 
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 .  کنیدانتخاب    Optionsپنلرا در  Digitizingبرگه 
 .کنیدتنظیم   To vertex and segmentرا به  Default snap modeحالت 

 .خط وصل شویداین امر به شما امکان می دهد تا به نزدیکترین بخش راس یا   
جای واحدهای نقشه تنظیم  به پیکسل در  Search radius for vertex editsو  Default snapping toleranceمن همچنین ترجیح می دهم   

 .ثابت می ماندمیزان زوم، می کند که فاصله جابجایی صرف نظر از امر تضمین این . کنم
 تأیید را کلیک کنید. مناسبی را انتخاب کنیدمقدار بسته به وضوح صفحه نمایش رایانه ،   
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 .شروع کنیمرقومی سازی را اکنون ما آماده هستیم تا 
 .ابتدا یک لایه جاده ایجاد خواهیم کرد و جاده های اطراف پارک را دیجیتالی می کنیم  
  Layer ‣ New ‣ New Spatialite Layer..    کنیدرا انتخاب. 

 .  کنیدایجاد  نیز  ...New Shapefile Layerصورت ترجیح می توانید یک لایه در 
   ...Spatialite  یک فرمت بانک اطلاعاتی باز شبیه به قالبgeodatabase ESRI بانک اطلاعاتی . استSpatialite  در یک پرونده منفرد در هارد

 .  و همچنین لایه های غیر فضایی باشد( نقطه ، خط ، چند ضلعی)دیسک شما قرار دارد و می تواند شامل انواع مختلفی از لایه های مکانی 
ایجاد می کنیم خطی یک لایه و (پولیگون )ضلعی لایه چند چند در این آموزش ، ما . بسیار ساده تر می شود shapefilesبه جای دسته ای از جابجایی آن این ترتیب به 

یا هر قالب  shapefileرا بارگیری کرده و آن را به عنوان  spatialiteهمیشه می توانید یک لایه . مناسب تر خواهد بود Spatialite، بنابراین یک پایگاه داده 
 .کنیددیگری که می خواهید ذخیره  
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نام . را ذخیره کنید nztopo.sqliteبا نام  spatialiteکلیک کنید و یک پایگاه داده جدید ... ، روی دکمه  New Spatialite Layerدر گفتگوی 
Layer  را به عنوانRoads  انتخاب کنید وLine as the Type را انتخاب کنید. 

جعبه کلید اصلی . کنیماز آن استفاده  است ، بنابراین می توانیم برای لایه جاده هایمان  EPSG:2193 - NZGD 2000در سیستم مختصات توپوگرافی پایه نقشه 
در جدول ویژگی ایجاد می شود و یک شناسه عددی منحصر به فرد را به طور  pkuidبا این کار فیلدی به نام . را علامت بزنید autoincrementingایجاد یک 

 .خودکار به هر ویژگی اختصاص می دهد
ویژگی اصلی  2، ما ای است از آنجا که این یک لایه جاده . اختیار شما است تصمیم بگیریدشاخصه در ، باید در مورد ویژگی هایی که هر  GISهنگام ایجاد یک لایه   

 .در قسمت ویژگی جدید ، نام را به عنوان نام ویژگی وارد کنید و بر روی افزودن لیست لیست کلیک کنید. نام و کلاس -خواهیم داشت 
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 کلیک کنیدرا   OK. را ایجاد کنیدمتنی از داده های جدیدی   Classبه طور مشابه 
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 .کلیک کنید تا لایه در حالت ویرایش قرار بگیرد  Toggle Editingپس از بارگیری لایه ، روی دکمه 
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 .جدید روی بوم نقشه کلیک کنید( vertex)راسبرای اضافه کردن یک . کلیک کنید( Add feature button)ویژگیروی دکمه افزودن 
 .جاده ، برای پایان دادن به ویژگی ، بر روی راست کلیک کنیدبخش پس از رقومی سازی . راسهای جدید را در طول ویژگی جاده اضافه کنید 
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 .  دریافت خواهید کرد Attributesنام پنلی به پس از کلیک راست برای پایان دادن به ویژگی ، 
 .را به صورت دستی وارد کنیدمقداری یک زمینه افزایش خودکار است ، شما نمی توانید  pkuidاز آنجا که . تازه ایجاد شده را وارد کنیدویژگی اینجا می توانید در 

تأیید را کلیک  . اختصاص دهیدنیز  Roadارزشی را به  به صورت اختیاری ، . ظاهر می شود ، نام جاده را وارد کنید topoآن را خالی بگذارید و همانطور که در نقشه   
 .کنید
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 .باریک استجدید، خطی فرض لایه استایل پیش 
 .را روی بوم ببینیمرقومی شده بگذارید آن را تغییر دهیم تا بتوانیم ویژگیهای  
 .را انتخاب کنید Propertiesکلیک راست کرده و   Roadsروی لایه  
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را از سبک های از  Primaryیک سبک خط ضخیم تر مانند . را انتخاب کنید Styleتب  Layer Propertiesپنل در 
 تأیید را کلیک کنید. پیش تعریف شده انتخاب کنید
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 .  شده را به وضوح مشاهده خواهید کردرقومی اکنون ویژگی جاده 
 .کلیک کنید  Save Layer Editsجدید در دیسک ، روی گزینه برای ایجاد ویژگی 
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به . قبل از دیجیتالی کردن جاده های باقیمانده ، مهم است که برخی از تنظیمات دیگر را برای ایجاد یک لایه بدون خطا به روز کنید
Settings ‣ Snapping Options....   بروید... 
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 .را فعال  کنید  Snapping Options  ،Enable topological editingدر کادر 
 .  این گزینه اطمینان حاصل می کند که مرزهای مشترک در لایه های چند ضلعی به درستی حفظ می شوند  

 .امکان ترسیم داشته باشیدکه به شما امکان می دهد بر روی تقاطع یک لایه پس زمینه کنید  فعال  را   Enable snapping on intersectionهمچنین 
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پس از . رقومی کنیدکلیک کرده و سایر جاده های اطراف پارک را ( Add feature)ویژگیاکنون می توانید بر روی دکمه افزودن 
مفید برای کمک به شما یکی از ابزارهای . کلیک کنید  Save Editsبرای ذخیره کار ، حتماً روی گزینه یک ویژگی جدید افزودن 

 .کلیک کنید  Node Toolبر روی دکمه . است  Node، ابزار رقومی کردن در 

m
o

z
a

ff
a

re
e

_
1

9
8

7
@

y
a

h
o

o
.c

o
m

ر 
و
پ
 
ی
ر
ف
ظ
م
 
ه
م
ج
ن

  
  
  

 

mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com


 .  برای انتخاب آن بر روی هر راس کلیک کنید. دهدپس از فعال شدن ابزار گره ، روی هر ویژگی کلیک کنید تا رئوس ها را نشان 
 .دهدرنگ می تغییر راس از انتخاب ، پس 

 .  این کار زمانی مفید است که می خواهید بعد از ایجاد ویژگی ، تنظیماتی را انجام دهید. حالا می توانید برای حرکت دادن راس موس خود را کلیک کرده و بکشید  
 (Macدر   Option+Delete). ، یک راس انتخابی را حذف کنید Deleteمی توانید با کلیک بر روی کلید همچنین 
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 .کنیدکلیک     Toggle Editingهمه جاده ها ، روی دکمه اتمام رقومی کردن پس از 

m
o

z
a

ff
a

re
e

_
1

9
8

7
@

y
a

h
o

o
.c

o
m

ر 
و
پ
 
ی
ر
ف
ظ
م
 
ه
م
ج
ن

  
  
  

 

mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com


 .ایجاد خواهیم کرد که نمایانگر مرزهای پارک است(  polygon)ضلعیاکنون یک لایه چند 
 .بروید  ...Layer ‣ New ‣ New Spatialite Layerبه برای این کار 

 Polygon. کنیدنامگذاری    Parksلایه جدید را به عنوان . را از لیست کشویی انتخاب کنید  nztopo.sqliteداده پایگاه 
 تأیید را کلیک کنید. ایجاد کنیدرا   Nameجدید ویژگی . انتخاب کنید Typeرا به عنوان 
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 .  روی دکمه افزودن ویژگی کلیک کرده و بر روی بوم نقشه کلیک کنید تا یک راس چند ضلعی اضافه شود
 .چند ضلعی را به عنوان پارک رقومی کنید

برای اتمام چند ضلعی کلیک راست  . حتماً به سمت راس جاده ها بچسبانید تا هیچ شکافی بین چند ضلعی های پارک و خطوط جاده وجود نداشته باشد 
 .کنید
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 .وارد کنید Atifibutesنام پارک را در پنجره 
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از تقاطع چند ضلعی جلوگیری )  Avoid intersections of new polygonsبه نام مفید دیگری بسیار چند ضلعیها تنظیمات 
 .را ارائه می دهند( جدیدهای 

 .بروید  ...Settings ‣ Snapping Optionsبه  
 را کلیک کنیدتأیید . را تیک بزنیددر ردیف  Avoid Intرا در ستون  Parksکادر مربوط به لایه  
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ضلعی سرعت چند با اجتناب از تقاطع چند ضلعی های جدید ، شما قادر خواهید بود به . اکنون برای افزودن چند ضلعی روی افزودن ویژگی کلیک کنید
 .چند ضلعی های همسایه داشته باشیدبه کنید بدون اینکه نگرانی در مورد چسبیدن رقومی  را 
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 .  کلیک کنیدترسیم چند ضلعی، راست  برای اتمام 
 !می خوردبهم ، چند ضلعی جدید دقیقاً در مرز چند ضلعی های همسایه بطورجادویی 

 .مرزهای پیچیده در جایی که لازم نیست خیلی دقیق باشید بسیار مفید است و هنوز هم چند ضلعی توپولوژیکی صحیح داریدرقومی کردن کار هنگام این  
 .کلیک کنید  Toggle Editing، روی  Parksبرای پایان ویرایش لایه   
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 .رقومی کنیداکنون زمان آن رسیده است که یک لایه ساختمان را 
 .ایجاد کنید Buildingsیک لایه چند ضلعی جدید با نام  Layer ‣ New ‣ New Spatialite Layerبا رفتن به   
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لایه . را خاموش کنید تا نقشه پایه توپو قابل مشاهده باشد Roadsو  Parks، لایه  Buildingsپس از افزودن لایه 
Buildings  را انتخاب کرده و رویToggle Editing  کلیک کنید. 
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است به طوری که لبه ها عمود بر هم باشند و مستطیل سختی به صورت دستی کار خط قائم همچنین اضافه کردن . دیجیتالی کردن ساختمانها می تواند یک کار دشوار باشد
 .تشکیل دهند

 .  استفاده خواهیم کرد Rectangles Ovals Digitizingکار از افزونه ای به نام راحتی در این  ما برای   
 .مشاهده کنید، می توانید نوار ابزار جدیدی را در بالای بوم  Rectangles Ovals Digitizingاز نصب افزونه پس 
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ماوس را بکشید تا یک کلیک کنید و    Rectangle by Extentکنید و دکمه مستطیل را با استفاده از بزرگنمایی  ساختمان در یک وجه 
 .به همین ترتیب ، ساختمانهای باقیمانده را اضافه کنید. ترسیم شودمستطیل 
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روی . ، باید مستطیل را در یک زاویه بکشیمساختمان برای مطابقت با . متوجه خواهید شد که برخی ساختمانها عمودی نیستند
Rectangle from center     کنیدکلیک. 
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 .روی مرکز ساختمان کلیک کرده و ماوس را بکشید تا یک مستطیل عمودی بکشید
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 .موجود است Advanced Digitizingابزار چرخش در نوار ابزار . برای مطابقت با تصویر روی نقشه توپو باید این مستطیل را بچرخانیم
 .را فعال کنید Advanced Digitizingبر روی یک ناحیه خالی در قسمت نوار ابزار کلیک راست کرده و نوار ابزار  
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 .کنیدکلیک     Rotate Feature(s)( چرخش ویژگی)روی دکمه 
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 .کنیداستفاده   Select Single featureابزاراز بچرخانید برای انتخاب چند ضلعی که می خواهید 
دقیقاً بر روی آن تکه های چرخدار  . را در مرکز چند ضلعی مشاهده کنیدخطوط متقاطع می توانید ، Rotate Featureپس از فعال شدن ابزار  

 .، ماوس را بکشیدداشته اید کلیک کنید و در حالی که دکمه کلیک سمت چپ را نگه 
 .تراز شودتصویرساختمان دکمه ماوس را رها کنید وقتی چند ضلعی با . ظاهر می شودچرخش پیش نمایش  
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می توانید لایه ها را . تمام ساختمانها روی تغییر گزینه ویرایش کلیک کنیدرقومی کردن را ذخیره کنید و بعد از اتمام لایه ها ویرایش 
drag    ترتیب ظاهری آنها تغییر کندکنید تا. 
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 .استشده رقومی سازی کامل اکنون کار 
زیبا طراحی کنید تا نقشه داده هایی که ایجاد کرده اید خوب برای ظاهر زدن، یک و برچسب استایل توانید با استفاده از گزینه های می 

 .به نظر برسد
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 OpenStreetMapو بارگیری داده های جستجو . 14

 .است   OpenStreetMap (OSM)با مجوز آزاد، یکی از منابع عالی برای داده های . ضروری است GIS گرفتن داده با کیفیت بالا برای هر کار •
 OSMخیابان ها ، داده های محلی ، چند ضلعی های ساختمان ، مرزهای اداری و غیره دسترسی به داده های  -شامل انواع نقشه برداری  OSMبانک اطلاعاتی   •

 .پذیر استامکان  QuickOSMطریق افزونه از   QGISدر  GISفرمت با  
 .در این آموزش روند جستجو ، بارگیری و استفاده از این افزونه توضیح داده شده است  •
داشته باشید که در زمان نوشتن این آموزش ، این توجه . جستجو و نصب کنید QGISدر  pluginsاز مخزن رسمی  را QuickOSMبرای این کار، افزونه •

تب در   Show also experimental pluginsکهعلامت گذاری شده است ، بنابراین مطمئن شوید   Experimentalافزونه به عنوان 
Settings  شده باشددر گفتگوی افزونه ها نصب  . 
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 .بیاورید   ... Vector ‣ QuickOSM -> QuickOSM پس از نصب ، افزونه را از 
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 .مجموعه تنظیم کنیدزیر را برای انتخاب فیلتری در برگه جستجوی سریع ، می توانید 
 .  داده می شوندنشان  valueو keyبرچسب ها با . به صورت برچسب ذخیره می شود OSMهای نقشه در پایگاه داده ویژگی 
key   موضوع است و یکvalue   فرم خاص استیک. 

Bars   شوند  استفاده از امکانات تگ نمایش داده می باamenity:bar  
 .کنیدانتخاب   keyبه عنوان  amenityاز منوی کشویی . استخراج می کنیمرا   barابتدا 
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 .انتخاب کنید Value barاز منوی کشویی 

m
o

z
a

ff
a

re
e

_
1

9
8

7
@

y
a

h
o

o
.c

o
m

ر 
و
پ
 
ی
ر
ف
ظ
م
 
ه
م
ج
ن

  
  
  

 

mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com


 .را وارد کنید Londonبرای محدود کردن جستجو در محدوده شهر ، 
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از . ویژگی ها با استفاده از گره ها ، روش ها و روابط ارائه می شوند  ، OSMدر مدل داده . را گسترش دهید Advancedبخش 
روی جستجوی درخواست کلیک  . را انتخاب کنید Pointsو  Nodeآنجا که ما به ویژگی های نقطه علاقه مندیم ، می توانید فقط 

 کنید
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لایه عنوان یک به ، داده ها را  Overpass APIبا استفاده از  OpenStreetMapو جو از پایگاه داده پس ازپرس افزونه 
 .می کندتبدیل برداری 
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 Layersبه پنل  amenity_bar_londonیک لایه جدید با نام . بروید QGISپس از اتمام پرس و جو ، به پنجره اصلی 

 .شده را نشان می دهدنقاط استخراج بوم محل . شده استاضافه 
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روی جستجوی درخواست  . ویرایش کنید Valueبه عنوان  pubبرگردید و پرس و جو را برای انتخاب  QuickOSMبه پنجره 
 کلیک کنید
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 .استخراج می کند OSMپایگاه داده را از  amenity:pubاین بار افزونه تمام نقاط برچسب 

m
o

z
a

ff
a

re
e

_
1

9
8

7
@

y
a

h
o

o
.c

o
m

ر 
و
پ
 
ی
ر
ف
ظ
م
 
ه
م
ج
ن

  
  
  

 

mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com
mailto:mozaffaree_1987@yahoo.com


 .اضافه می شود Layersبه پانل  amenity_pub_londonلایه جدیدپس از تکمیل پرس و جو ، 
برداری لایه دریک بیایید اینها را . از بین می روند QGISازحافظه موقتی هستند که پس از خروج هایی در اینها لایه . داریمبرداری لایه  2اکنون  

 .به جعبه ابزار پردازش بروید. دیسک ذخیره کنیمسپس در واحد ادغام کنیم و 
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 .برای راه اندازی آن دوبار کلیک کنید. کنیدجستجو  را   Vector general ‣ Merge vector layersابزار 
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هر دو لایه . کنار لایه های ورودی کلیک کنید... روی دکمه  ، Merge Vector Layersدر گفتگوی 
amenity_pub_london  وamenity_pub_london    تأیید را کلیک کنید. کنیدرا انتخاب 
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 .را انتخاب کنید  Save to GeoPackageدر کنار ادغام کلیک کنید و گزینه ... روی دکمه 
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 .به آن بدهید longon.gpkgبه دایرکتوری بروید که می خواهید داده را ذخیره کنید و نام خروجی 
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 .عنوان نام لایه وارد کنیدرا به  bars_and_pubsنام  
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 .کلیک کنید Runبرای اجرای فرآیند ادغام ، روی 
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خواهید دید که . مشاهده خواهید کرد Layersاضافه شده در پنل  bars_and_pubsپس از اتمام پردازش ، یک لایه جدید 
 .ویژگی ها از هر دو لایه قبلی استجمع تمام این لایه 

 .را انتخاب کنید Open Attribute Tableراست کلیک کنید و  bars_and_pubsروی لایه   
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همراه نام این موسسات و سایر به  barو pubدر جدول ویژگی ها خواهید دید که این لایه حاوی هر دو نوع سرویس های 
 .خصوصیات است
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 .لندن رسیده ایمدر   barو pubما به هدف استخراج 
اما شاید شما در شرایطی قرار بگیرید که برای به دست آوردن مجموعه ای مناسب جستجو کنیم ، جداگانه شدیم داده ها را برای به دست آوردن داده های مربوطه و ادغام مجبور   

 .پیچیده را انجام دهیدجوی از داده ها برای پروژه خود ، باید یک پرس و 
 .راهی برای نوشتن و اجرای نمایش داده های سفارشی فراهم می کند QuickOSMخوشبختانه ، افزونه   
 .کار مورد نظر بنویسیمجوی واحد برای  بیایید ببینیم که چگونه می توانیم یک پرس و   
 .کلیک کنید Show queryبروید و بر روی  QuickOSMبه پنجره   
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 .تغییر خواهد کرد Queryاین افزونه به برگه 
 .پرس و جوهای ساخته شده را بر اساس ورودی کاربر نشان می دهد Overpassبخش پرس و جو  
 .این قسمت قابل ویرایش است و می توانید هر پرس و جو را وارد کنید 
 .است  Overpass Query (QL)قالب پرس و جو در زبان  
 .انتخاب کرده و آن را کپی کنیدرا  query> ... </query> XML>برای این منظور ، بین برچسبهای  
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 .  اضافع کنید  barبه  pubآن را از مقدار بعد از جستجوی بخش موجود ، 
 روی جستجوی درخواست کلیک کنید. واحد منتقل می کندجوی پرس و به یک وجود دارد که مقادیر هر دو برچسب را جوی کاملی زیر پرس و در 
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<osm-script output="xml" timeout="25"> 

 <id-query {{geocodeArea:London}} into="area_0"/>  

<union>  

<query type="node"> 

 <has-kv k="amenity" v="pub"/>  

<area-query from="area_0"/> 

 </query> 

 <query type="node"> 

 <has-kv k="amenity" v="bar"/> 

 <area-query from="area_0"/>  

</query> 

 </union>  

<union> 

 <item/> 

 <recurse type="down"/>  

</union>  

<print mode="body"/> 

 </osm-script>  
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این لایه شامل نقاطی است که . اضافه می کنید Layersبه پانل  OsmQueryپس از اتمام پرس و جو ، یک لایه جدید 
 .لندن استدر  pubsو  barsنمایانگرکلیه ی  
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